User's Guide

Version 5
## Contents

**Notices** ................................................................. v
  Trademarks ............................................................... v

**About This Book** ......................................................... vii
  What's Changed in This Book ........................................... vii
  Publishing History ..................................................... vii
  Changes Made in the Eighteenth Edition ............................ viii
  Changes Made in Previous Editions ................................... viii

**Chapter 1. Introducing the Softcopy Librarian** ................. 1
  What the Softcopy Librarian Can Do for You ......................... 1
  Some Terms You Should Know .......................................... 3
  Overview of Setting Up the Softcopy Librarian ...................... 3
  Overview of Using the Softcopy Librarian .......................... 3

**Chapter 2. Hardware and Software Requirements** ............... 5
  Hardware and Software Requirements for Your Workstation ........ 5
  Hardware/Software Requirements for OS/390 or z/OS Host Repositories 5
  Hardware and Software Requirements for a Unix-like Repository .... 6
  Hardware and Software Requirements for Your PC or LAN Repository 6

**Chapter 3. Planning for Your Repositories** ....................... 7
  What Does the Softcopy Librarian Manage? ......................... 7
  How Many Repositories Might I Need? ............................... 7
  Where Can I Locate My Repositories? ................................ 8
  What Information Must I Gather before I Can Define a Repository 8
  Take the Next Step ..................................................... 9

**Chapter 4. Installing the Softcopy Librarian** ..................... 11
  Locating the Softcopy Librarian installation package .......... 11
  Determining If a Later Version Is Available for Download ........ 11
  Checking for a Later Version Automatically ....................... 11
  Checking for a Later Version Manually ............................. 11
  Installing the Softcopy Librarian on a Windows Workstation .... 12

**Chapter 5. Starting the Softcopy Librarian** ....................... 13
  Starting the Softcopy Librarian From a Windows Workstation .... 13
  How You Can Use the Softcopy Librarian Main Window .............. 13
  The Menu Bar ............................................................ 13

  Using the Softcopy Librarian windows .............................. 14
  What to Do Next .......................................................... 20

**Chapter 6. Setting Up Your Connection to the Internet** .......... 23
  Setting Up an Internet Connection .................................... 23

**Chapter 7. Migrating from Previous Versions of the Softcopy Librarian** 25
  Migrating from V4.1 to V4.2 ........................................... 25
  Migrating from V4.2 to V4.3 or V4.6 ................................ 25
  Migrating from V4.3 or V4.6 to V5.0 ................................. 25

**Chapter 8. Setting Up a z/OS or OS/390 Host Repository Using Sequential Data Sets** 27
  Considerations for Setting Up Your Repository ..................... 27
  Using Sequential Data Sets ............................................ 27
  Setup Required at Your z/OS or OS/390 Host Repository ............ 27
  Defining a z/OS or OS/390 Host Repository ........................ 28

**Chapter 9. Setting Up a z/OS or OS/390 Host Repository Using the Unix System Services HFS** 33
  Considerations for Setting Up a Repository in Hierarchical Files 33
  Information You Must Gather about Your Repository ................ 33
  Defining a z/OS or OS/390 UNIX System Services Host Repository .... 34

**Chapter 10. Setting Up a Unix-like Repository** .................. 37
  Considerations for Setting Up Your Repository ..................... 37
  Defining a Unix Server Repository .................................... 37

**Chapter 11. Setting Up a PC/LAN Repository** ..................... 41
  Considerations for Setting Up Your Repository ..................... 41
  Defining a PC or LAN Server Repository ............................ 41

**Chapter 12. Creating and Recreating the Catalog for Your Repository** 45
  Updating Your Catalog Automatically ................................ 45
  Creating or Recreating the Catalog Manually ....................... 46
  When and How to Erase the Cache That the Softcopy Librarian Uses 46

**Chapter 13. Identifying the Sources of Content That You Want to Transfer** 49
  Identifying a CD Reader or Hard Drive as the Source .............. 49
Notices

References in this publication to IBM products, programs, or services do not imply that IBM intends to make these available in all countries in which IBM operates.

Any reference to an IBM product, program, or service is not intended to state or imply that only IBM's product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any of IBM's intellectual property rights may be used instead of the IBM product, program, or service. Evaluation and verification of operation in conjunction with other products, except those expressly designated by IBM, is the user's responsibility.

IBM may have patents or pending patent applications covering subject matter in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to the IBM Director of Licensing, IBM Corporation, 500 Columbus Avenue Thornwood, NY 10594, U.S.A.

Trademarks

The following terms, denoted by an asterisk (*), in this publication are trademarks or service marks of the IBM Corporation in the United States or other countries or both.

IBM
IBMLink
MVS/ESA
OS/390
S/390
VM/ESA
z/OS

The following terms, denoted by a double asterisk (**), in this publication, are trademarks or service marks of other companies.

Java is a trademark of Sun Microsystems, Inc.
Microsoft, Windows, Windows 7, and Windows Vista are trademarks or registered trademarks of the Microsoft Corporation in the United States and other countries.
UNIX is a registered trademark in the United States and other countries licensed exclusively through X/Open Company Limited.
About This Book

This book describes how to set up and use IBM Softcopy Librarian. The Softcopy Librarian (SCL, program number 5648-032) lets you transfer shelves, books, PDFs, Knowledge Center content and other publications to a repository and manage them there. One or more repositories can be set up on:

- A z/OS host running IBM TCP/IP FTP
- An OS/390 host running IBM TCP/IP FTP
- A Unix-like server, accessible through FTP
- A LAN hard drive, accessible using Copy commands
- A local PC hard drive, accessible using Copy commands

The Softcopy Librarian runs on a Windows 7 or Vista workstation.

To use the Softcopy Librarian, you would do the following:

1. Set up at least one repository for softcopy files that you want to manage.
2. Create a catalog for that repository.
3. Transfer files from a CD, from a local hard drive on your workstation, from the IBM PUBLIB Web site, or from any other Web site that can support the Softcopy Librarian.

When you transfer files from any of these sources to your repository, the Softcopy Librarian compares what you want to transfer with the catalog.

4. The Softcopy Librarian then lists the items that you do not have in your repository and the items that have changed since the last time you updated the repository.
5. You can select and transfer only those items that you do not have or that have been updated.

The Softcopy Librarian lists everything that is in your repository and lets you delete objects that have been replaced or that are no longer needed.

What’s Changed in This Book

This section summarizes the major changes made in the current edition of the Softcopy Librarian: User’s Guide.

Publishing History

The following table shows the publication history of this manual:

<table>
<thead>
<tr>
<th>Product Version/Release</th>
<th>Edition</th>
<th>Date</th>
<th>Order Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>V5</td>
<td>Eighth</td>
<td>August, 2015</td>
<td>GC23-3414-17</td>
</tr>
<tr>
<td>V4.3</td>
<td>Seventh</td>
<td>January, 2009</td>
<td>GC23-3414-16</td>
</tr>
<tr>
<td>V4.2</td>
<td>Sixteenth</td>
<td>July, 2007</td>
<td>GC23-3414-15</td>
</tr>
<tr>
<td>V4.2</td>
<td>Fifteenth</td>
<td>September, 2004</td>
<td>GC23-3414-14</td>
</tr>
<tr>
<td>V4.2</td>
<td>Fourteenth</td>
<td>June, 2004</td>
<td>GC23-3414-13</td>
</tr>
<tr>
<td>V4.2</td>
<td>Thirteenth</td>
<td>October, 2003</td>
<td>GC23-3414-12</td>
</tr>
<tr>
<td>V4.2</td>
<td>Twelfth</td>
<td>August, 2003</td>
<td>GC23-3414-11</td>
</tr>
<tr>
<td>V4.1</td>
<td>Eleventh</td>
<td>December, 2002</td>
<td>GC23-3414-10</td>
</tr>
<tr>
<td>V4.1</td>
<td>Tenth</td>
<td>July, 2002</td>
<td>GC23-3414-09</td>
</tr>
</tbody>
</table>
Table 1. Publication History (continued)

<table>
<thead>
<tr>
<th>Product Version/Release Service Level</th>
<th>Edition</th>
<th>Date</th>
<th>Order Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>V4.1</td>
<td>Ninth</td>
<td>September 2001</td>
<td>GC23-3414-08</td>
</tr>
<tr>
<td>V4.0C</td>
<td>Eight</td>
<td>March 2001</td>
<td>GC23-3414-07</td>
</tr>
<tr>
<td>V3.5B</td>
<td>Seventh</td>
<td>September 2000</td>
<td>GC23-3414-06</td>
</tr>
<tr>
<td>V3.5</td>
<td>Sixth</td>
<td>June 2000</td>
<td>GC23-3414-05</td>
</tr>
<tr>
<td>V3.4</td>
<td>Fifth</td>
<td>December 1999</td>
<td>GC23-3414-04</td>
</tr>
<tr>
<td>V3.2D</td>
<td>Fourth</td>
<td>September 1999</td>
<td>GC23-3414-03</td>
</tr>
<tr>
<td>V3.2</td>
<td>Third</td>
<td>June 1999</td>
<td>GC23-3414-02</td>
</tr>
<tr>
<td>V3.1</td>
<td>Second</td>
<td>March 1999</td>
<td>GC23-3414-01</td>
</tr>
<tr>
<td>V3.0</td>
<td>First</td>
<td>September 1998</td>
<td>GC23-3414-00</td>
</tr>
</tbody>
</table>

The current edition is listed first.

Changes Made in the Eighteenth Edition
New Information

Support for IBM® Knowledge Center for z/OS® and Knowledge Center content delivery.

Removed references in this publication to support for Windows XP.

Added references in this publication to support for Windows 7.

Changes Made in Previous Editions
For a summary of the changes made in the previous editions of this book, refer to Appendix E, "Summary of Changes Made in Previous Editions," on page 71.
Chapter 1. Introducing the Softcopy Librarian

This section introduces and summarizes:
- What the IBM Softcopy Librarian can do for you
- How to install the IBM Softcopy Librarian
- How to set up a repository
- How to create a catalog for your repository
- How to upload shelves, books, and .zip files of Knowledge Center plugins
- How to maintain your repository

What the Softcopy Librarian Can Do for You

The IBM Softcopy Librarian V5 provides you with the ability to manage softcopy shelves and associated publications. These can either be provided by IBM or built using the IBM BookManager shelf architecture and BookManager Build or Builder application for softcopy publications.

The Softcopy Librarian provides these capabilities:
- Manages the following types of files and file types (MVS and Local Unix)
  - Books (BOOK and .BOO files)
  - Shelves (BKSHELF or .BKS files)
  - Extended Shelves (XKSHELF or .XKS files)
  - Shelf Indexes (BKINDEX or .BKI files)
  - PDFs (PDF files)
  - IBM Knowledge Center for z/OS content (.ZIP files of plugins)
- Active Management, in addition to transferring files, also includes:
  - Maintaining a catalog of the contents for each of your repositories
  - Comparing what’s currently in your repositories with new sources of shelves, books, PDFs, Knowledge Center content and other publications
  - Providing you with the comparative status of the items in the source in relation to the contents of your current repositories
  - Updating the catalogs whenever you transfer new shelves, Books, PDFs, Knowledge Center content and other publications to your repositories
  - Identifying items in your repositories that can be removed because there are newer versions of these items also in your repositories
- Set up and maintain repositories using a variety of sources. You can obtain and transfer content and associated publications from:
  - CD collections from IBM
  - OEM (Original Equipment Manufacturers) CD Collections
  - The IBM PUBLIB Web site (over the Internet)
  - A local hard disk
  - Other Web sites (that provide support for the Softcopy Librarian)
- Tracking of New and Updated Knowledge Center content, as well as Updated shelves and associated publications
  The Softcopy Librarian keeps a catalog of all the Knowledge Center content, as well as the shelves and associated publications that you send to your repository from any level of a CD, from your local hard drive, from the IBM PUBLIB Web site, or any other Web site that supports the Softcopy Librarian.
When a new level of a shelf or Knowledge Center content arrives, on a new CD or downloaded from a
web site, the Softcopy Librarian compares it and its contents with the catalog and shows you whether
it's brand new or whether it's changed since the last level you received. You now have a way to see at
a glance which Knowledge Center content or shelves on a CD or on a supported web site are currently
in your host repository.

- Support for OS/390 and z/OS Repositories
  The Softcopy Librarian supports repositories in sequential data sets for all content other than
  Knowledge Center content. You can use BookManager READ/MVS to access the books, shelves and
  other publications on your OS/390 or z/OS host. All communication with the host is done via FTP.
  - Current support is for IBM TCP/IP FTP only.
  - BookManager READ/MVS requires service for APAR PQ75262 when, or before you upload
    extended shelves (XKS files).

- Support for OS/390 and z/OS Unix System Services Repositories
  The Softcopy Librarian supports repositories in either hierarchical file systems or sequential data sets.
  You can use BookManager BookServer for z/OS or OS/390, or Library Server to access the books,
  shelves, and other publications, or use IBM Knowledge Center for z/OS to access Knowledge Center
  plugins on your z/OS or OS/390 host or server. All communication with the host is done via FTP.
  - Current support is for IBM TCP/IP FTP only.

- Support for Unix-like Repositories
  The Softcopy Librarian supports repositories on Unix-like servers. You can use BookManager
  BookServer/Library Center for AIX to access the books, shelves, PDFs and other publications on your
  Unix-like server. All communication with the host is done via FTP.
  - Current support is for IBM TCP/IP FTP only.

- Support for PC/LAN Repositories
  The Softcopy Librarian supports repositories on LAN server or local personal computer hard drives
  that can be accessed as a drive letter on Windows systems. The drive must be a valid target for a Copy
  command. You can use the BookManager Softcopy Reader to access the shelves, books, PDFs and other
  publications on your LAN server or PC workstation. Although Softcopy Librarian can maintain
  Knowledge Center content on an PC/LAN repository, Softcopy reader does not support Knowledge
  Center content.

- Support for PDF files
  The Softcopy Librarian supports PDF files and Extended Shelves to organize them, obtained from
  either the "PUBLIB" web site, or the Collection "CD."
  - READ/MVS requires service for APAR PQ75262, if you place extended shelves in a z/OS or PS/390
    sequential dataset repository.

- Managing Your Own and Other Manufacturer's Books, PDFs, .zip files and other publications
  The Softcopy Librarian will let you track shelves, books, PDFs, Knowledge Center content and other
  publications that you create or that you might receive with product from companies other that IBM.

Note: CD Collections of softcopy shelves and associated publications from others - OEM (Original
Equipment Manufacturers) - must be built using the IBM BookManager shelf architecture (for shelves
containing books), or the extended shelf architecture (for shelves containing PDFs) and BookManager
Build or builder application for the softcopy publication. Use IBM BookManager Softcopy Reader or
Shelf Organizer to build extended shelves.

- Available on all IBM Online Library CDs and from the IBM Web Site
  The Softcopy Librarian is available, at no cost, on all IBM Online Library collections and on other IBM
  product CDs.
  The latest version of the Softcopy Librarian is also available and can be downloaded from the
Some Terms You Should Know

Here are some Softcopy Librarian terms with which you should become familiar:

Source
Is the place from where you can obtain the Knowledge Center content or the shelves and associated publications that you want to place into your repositories. Sources can include:
- CD drive for CD collections from IBM or other manufacturers
- The Internet for connection to IBM's online library or other online libraries
- A local hard drive or server for Knowledge Center content and for shelves and associated publications you can create

Repository
Is the place where your softcopy items are stored. During Softcopy Librarian setup, you specify where the repository is located and how to access it. You can define multiple repositories in these locations:
- OS/390 or z/OS host sequential data sets - identified by a high-level qualifier
- OS/390 or z/OS Unix System Services hierarchical file system - identified by an HFS directory,
- A Unix-like server - identified by a Unix-like directory
- A hard drive on a local PC or LAN server - identified by a PC directory

Catalog
Is a Softcopy Librarian file that lists the softcopy items contained in a Softcopy Librarian repository. You can create a catalog when you set up a new, empty repository. However, the catalog is automatically updated every time you use the Softcopy Librarian to update your repository. The Softcopy Librarian builds a catalog by querying the contents of the directory or the high-level qualifier (HLQ) specified during the setup of the repository and then builds the catalog information.

Overview of Setting Up the Softcopy Librarian

In general, the steps that you must plan for are:
1. Determine whether your hosts and workstations meet the hardware and software requirements for using the Softcopy Librarian. Refer to Chapter 2, “Hardware and Software Requirements,” on page 5.
2. Install the Softcopy Librarian on your workstation. Refer to Chapter 4, “Installing the Softcopy Librarian,” on page 11.
3. Set up one or more repositories. For OS/390 or z/OS repositories in sequential data sets, refer to Chapter 8, “Setting Up a z/OS or OS/390 Host Repository Using Sequential Data Sets,” on page 27. For OS/390 or z/OS repositories in OS/390 or z/OS Unix System Services hierarchical files, refer to Chapter 9, “Setting Up a z/OS or OS/390 Host Repository Using the Unix System Services HFS,” on page 33. For a Unix-like repositories, refer to Chapter 10, “Setting Up a Unix-like Repository,” on page 37. For a PC or LAN repositories, refer to Chapter 11, “Setting Up a PC/LAN Repository,” on page 41.
4. Create a catalog for each repository. Refer to Chapter 12, “Creating and Recreating the Catalog for Your Repository,” on page 45.
5. Transfer content and associated publications to your repositories. Refer to Chapter 14, “Maintaining Your Repositories,” on page 51.
6. Maintain the repositories by identifying, replacing and/or deleting softcopy items. Refer to Chapter 14, “Maintaining Your Repositories,” on page 51.

Overview of Using the Softcopy Librarian

After you have installed and set up the Softcopy Librarian, you can use it to help you:
• Compare the contents of any source (that is, a CD you received, the contents of a supported Web site, or the hard drive of a server) with the catalog for any of your repositories. This comparison will show you which shelves, Books, PDFs, Knowledge Center content and associated publications on that source are new, updated, installed, partial, or downlevel.

**New** Have not appeared on that source previously and are not currently in your repository.

**Updated**
Are at a more recent level than the ones in your repository; you installed them from a previous release of this collection, and they have been updated on this collection.

**Unchanged**
Were included in the previous release of this collection, but you did not install them in your repository; they have not been updated since then.

**Installed**
Are already in your repository; you installed them previously, and they have not been updated since then.

**Partial**
Are already in your repository; you installed them previously, but the shelves in your repository are missing books.

**Downlevel**
Are at an earlier level than the ones your repository. This usually occurs if you are viewing a CD that is older than the previous CD you used.

• Upload only new or updated shelves and Knowledge Center content, or partial shelves to your repository. This saves you time and DASD space and still keeps your repository up to date. The catalog is updated automatically whenever you upload to the repository.

• Maintain your host repository.

The Softcopy Librarian shows you which shelves or Knowledge Center content in your repository can be replaced by the new and updated shelves or .zip files that you just transferred.

You can:
- List the Books, PDFs or other publications in a shelf
- See which Books, PDFs or other publications if any, are missing from any of the shelves
- See which Books, PDFs, and other publications are “orphaned,” that is, not in any shelf.

All this makes it easy for you to delete the shelves, Books, PDFs, Knowledge Center content or other publications that have been replaced or are no longer needed.
Chapter 2. Hardware and Software Requirements

This chapter describes the hardware and software required to install and use the Softcopy Librarian on your hosts and workstations.

Hardware and Software Requirements for Your Workstation

This section describes the software and hardware requirements for the workstation on which you will do the following:

- Install the Softcopy Librarian.
- Create a catalog of softcopy that resides in your repositories.
- Transfer softcopy shelves, books, PDFs, Knowledge Center content and other publications to your repository.

It must have the following hardware and software:

A **workstation** that consists of:
- A 1GHz equivalent or faster processor.
- One of the following operating systems:
  - Windows 7 or Windows Vista
  - To use OS/390 or z/OS repositories, a TCP/IP link that supports FTP communications with your host.
    - Current support is for IBM TCP/IP FTP only.
  - To use LAN server repositories, a network connection which allows you to access the LAN server as a drive letter.
  - To use local PC repositories, no additional requirements.
  - To use CD-ROM collections as a source, a CD-ROM drive.
  - To use the Internet as a source or to check for updates to the Softcopy Librarian, an Internet connection.
  - A minimum of 100MB of space on your hard drive.

Hardware/Software Requirements for OS/390 or z/OS Host Repositories

This section describes the software and hardware requirements for an OS/390 or z/OS host on which you will maintain one or more softcopy repositories.

Your host must have the following hardware and software:

A **Host** system that consists of:
- One of the following operating systems:
  - z/OS
  - OS/390
  - MVS
- A TCP/IP link that supports FTP communications from your workstation
  - Current support is for IBM TCP/IP FTP only.
- Your destination host must be inside your firewall, the Softcopy Librarian does not provide proxy support for this transfer.
• Sufficient DASD space for the Knowledge Center content, shelves, Books, PDFs and other publications that will reside in your repositories.

• If you plan to:
  – Use sequential dataset repositories, and
  – store extended shelves in them, and
  – allow your users to use READ/MVS

Then you must install service for READ/MVS APAR PQ75262, to prevent READ/MVS from listing Extended Shelves in its List of Shelves (READ/MVS does not currently support extended shelves).

Hardware and Software Requirements for a Unix-like Repository

This section describes the software and hardware requirements for a Unix-like server on which you will maintain one or more softcopy repositories.

Your server must have the following hardware and software:
• One of the following operating systems:
  – AIX
  – Linux
  – Any other Unix type operating system
• A TCP/IP link that supports FTP communications from your workstation
  Current support is for IBM TCP/IP FTP only.
  Your destination server must be inside your firewall, the Softcopy Librarian does not provide proxy support for this transfer.
• Sufficient DASD space for the shelves, Books, PDFs and other publications that will reside in your repositories.

Hardware and Software Requirements for Your PC or LAN Repository

This section describes the software and hardware requirements for a PC or LAN on which you will keep your softcopy repositories.

• You must be able to access the repository's directory as a drive letter.
• Sufficient DASD space for the Knowledge Center content, shelves, Books, PDFs and other publications that will reside in your repositories.

If you meet the requirements for installing and using the Softcopy Librarian, when you are ready, you can continue with the information in Chapter 3, “Planning for Your Repositories,” on page 7 to help plan your repositories.
Chapter 3. Planning for Your Repositories

This chapter discusses what you will need to know and some of the decisions that you must make in preparation for setting up your own repositories of shelves, books, PDFs, Knowledge Center content and other publications.

Note: In addition to, or instead of, setting up your own repositories, you can access the IBM Online Library on the Internet at this URL:

You need only a browser to access the entire z/OS, OS/390, z/VM, VM, and VSE libraries.

What Does the Softcopy Librarian Manage?

The Softcopy Librarian actively manages the following types of files:

• BookManager files and file types (MVS and Local UNIX)
  – Books (BOOK or .BOO files).
  – Shelves (BKSHELF or .BKS files).
  – Extended Shelves (XKSHELF or .XKS files).
  – Shelf indexes (BKINDEX or .BKI files).
• PDFs (PDF files).
• Knowledge Center for z/OS content (.ZIP files of plugins)

Active management involves not just transferring files to your repositories, it also includes:

• Maintaining a catalog of the contents for each of your repositories.
• Comparing what's currently in your repositories with new sources of shelves, books, PDFs, Knowledge Center content and other publications.
• Providing you with the comparative status of the items in the source in relation to the contents of your current repositories.
• Updating the catalogs whenever you transfer new shelves, books, PDFs, .zip files and other publications to your repositories.
• Identifying items in your repositories that can be removed because there are newer versions of these items also in your repositories.

How Many Repositories Might I Need?

The simplest arrangement is one repository that anyone can access. You must define at least one repository for the Softcopy Librarian to function.

You might need more than one repository depending upon several factors, which can include:

• All your users do not have access to the same host or server.
• Even if they are on the same host they may not have access to the same LPAR.
• You have a large number of Books, PDFs, Knowledge Center content and other publications that are easier to manage in unique sets, for example, IBM and non-IBM.
• If you are migrating from one version or release of a system to another, you might want to keep the Books, PDFs, Knowledge Center content and other publications in separate repositories to make it easier to delete the older set.
If you are running a test release of your system along with your production release, you might want to keep the two separate from each other.

**Where Can I Locate My Repositories?**

You can set up one or more host repositories of softcopy shelves, books, PDFs, Knowledge Center content and other publications in any of the following places:

- On z/OS or OS/390 hosts:
  - In sequential data sets (except for Knowledge Center content)
  - In the hierarchical files (HFS) of Unix System Services
- On Linux, AIX or other Unix-like servers
- On LAN servers
- On local workstations

**What Information Must I Gather before I Can Define a Repository**

You must provide the following information when you define your repository:

- The arrangement of your repositories.
  - How many you plan to have
  - What they will contain
  - Where they will be located
- For all repositories: A name for each new repository.

  **Note:** This name can be anything you want. It is the name that the Softcopy Librarian uses on your workstation to identify your repositories.

- For host and Unix-like repositories only: The name or IP address and the user ID and password you use to access your host or server.
- For all repositories: High-level qualifiers or directories, which will contain these files:
  - Book (.BOOK or .BOO)
  - Index (.BKINDEX or .BKI)
  - PDF (.PDF)
  - Shelves (BKSHELF or .BKS)
  - Extended Shelves (.XKSHELF or .XKS)
  - Knowledge Center content

  **Restriction:** Knowledge Center for z/OS content must be stored in directories and cannot be stored in sequential datasets.

  **Note:** For host repositories in sequential data sets only: Your shelves and books do not require unique HLQs. For example, if your BookManager code is installed under IBMBK, then the shelves and related publications could be installed under IBMBK.SOFTCOPY.

- For host repositories in sequential data sets only
  - A high-level qualifier for the Softcopy Librarian's shelf list.
  - The type of DASD device you are using
  - The block size for that DASD device (provided)
  - The volume in which the data sets will reside
- For SMS users only: The applicable data, management, and storage classes that you are using
- For host, Unix-type, and LAN server repositories only Any FTP commands required by your location to transfer the shelves and associated publications from the workstation to your host or server.
Take the Next Step

When you are ready to create your repositories, continue with the instructions in Chapter 8, “Setting Up a z/OS or OS/390 Host Repository Using Sequential Data Sets,” on page 27, Chapter 9, “Setting Up a z/OS or OS/390 Host Repository Using the Unix System Services HFS,” on page 33, Chapter 10, “Setting Up a Unix-like Repository,” on page 37, or Chapter 11, “Setting Up a PC/LAN Repository,” on page 41.
Chapter 4. Installing the Softcopy Librarian

This chapter describes:

- Where you can find the Softcopy Librarian installation package.
- How to determine which version is available for download.
- How to determine whether an updated version is available.
- How to install the Softcopy Librarian on Microsoft Windows 7 or Windows Vista workstation.

Locating the Softcopy Librarian installation package

The installation package is located on the CD-ROM containing tools, which is part of the IBM Online Library collections. The package is also located on the DVD, which is part of the IBM Online Library DVD collections. The package, in a file named EBRSCMLWJ.EXE, is in the SCL directory.

\SCL\EBRSCLMJ.EXE

The latest version of the install package for Windows is also available at this Web address:

Determining If a Later Version Is Available for Download

From time-to-time, an updated version of the Softcopy Librarian is made available for download from the IBM Softcopy Librarian Web site. If you are using a Windows workstation, you can check automatically or manually if a later version than the one you currently have installed on your workstation is available. You might want to do either of these checks occasionally.

Checking for a Later Version Automatically

To check automatically, do the following:

1. On the Softcopy Librarian’s menu bar, select Help.
2. In the Help pull-down menu, select Check for Updates (automatic).
   
   The Check for Updates (automatic) choice will compare the version that you have installed with the version that is currently available at the IBM PUBLIB Web site.
3. If there is a later version available at the Web site, you will be asked if you want to download it. If you do, click OK.
   
   If you choose to download it, you will also be asked if you want to install it.
4. If you want to install the new version, click OK.
   
   If you choose to install it, follow the instructions in “Installing the Softcopy Librarian on a Windows Workstation” on page 12.

Note: If, because of your firewall, the Softcopy Librarian cannot perform the automatic check, you can use the manual check.

Checking for a Later Version Manually

To check manually, do the following:

1. Locate the Check for Updates (manual) choice. Do one of the following:

   - From the Windows desktop, go to Start > Programs > IBM Softcopy Librarian V5 > Service > Check for Updates (manual).
   - From the Softcopy Librarian’s menu bar, select Help > Check for Updates (manual).
The Check for Updates (manual) choice, presents you with an HTML page containing a link to the Softcopy Librarian's Readme file.

2. Click on the link to the Readme file and look at the version listed.
   The first line of the Readme contains the version number.
3. Compare the version listed in the Readme with the version that you have installed.
   The Readme also explains how to determine which version you have installed.
4. If there is a later version available on the Web site, you can download the Windows version of the Softcopy Librarian install package.

### Installing the Softcopy Librarian on a Windows Workstation

To install the Softcopy Librarian on a Windows workstation, do the following:

1. Locate the install package EBRSCLWJ.EXE and invoke it from Windows Explorer, the Start->Run prompt, or a command prompt.
   The InstallShield Wizard window appears. When the Softcopy Librarian code is unpacked, the Choose Destination Location window appears in the IBM Softcopy Librarian Setup screen.
2. In the Choose Destination Location window, you can accept the default destination `C:\Program Files\IBM\IBM SoftCopy Librarian V5` or choose another. When you are ready, click the Next> button.
   The Start Copying Files window appears to confirm your choices.
3. In the Start Copying Files window, click the Next> button.
   A progress indicator shows the Softcopy Librarian files being installed. When the installation is complete, the Installation Wizard Complete window appears.
4. In the Installation Wizard Complete window, click the Finish button.

After you have installed the Softcopy Librarian code, you are ready to start the Softcopy Librarian and prepare your host or server for setting up a repository. Continue with the instructions in Chapter 5, "Starting the Softcopy Librarian," on page 13.

---

IBM Softcopy Librarian: User's Guide
Chapter 5. Starting the Softcopy Librarian

This chapter describes how to start the Softcopy Librarian on a Windows workstation.

Starting the Softcopy Librarian From a Windows Workstation

To start the Softcopy Librarian, do the following:

1. Double-click the Softcopy Librarian icon on the Windows desktop or go to Start > Programs > IBM Softcopy Librarian V5 > Softcopy Librarian. The Softcopy Librarian window appears. If you are starting the Softcopy Librarian for the first time: The SCL - First Time Usage window will also open.

2. Set up a default source for your CD-ROM drive: type the drive letter for your CD-ROM drive in the CD-ROM Drive field.
   The Softcopy Librarian will create a default source using your CD-ROM drive.

3. Click on the Define CD Source button.
   The default source will be named CD-ROM - x\ drive.
   If you have previously installed and set up the Softcopy Librarian and know how to use it, you can continue with the instructions in Chapter 14, "Maintaining Your Repositories," on page 51.
   If you are not familiar with the Softcopy Librarian window and how to use it, you can continue reading "How You Can Use the Softcopy Librarian Main Window" for a description of the main window and what you can do next.

How You Can Use the Softcopy Librarian Main Window

The Softcopy Librarian main window contains a menu bar and several windows. The following descriptions will help you become familiar with the location and contents of the items in the main window.

The Menu Bar

The menu bar contains the following choices:

- **File**
  This selection contains the following choice:
  - **Exit**
    This closes the Softcopy Librarian.

- **Settings**
  This selection contains the following choice:
  - **Proxy**
    This permits you to define the type of Internet connection that you are using:
    - Direct - without a firewall
    - Proxy - with a firewall
  - **Trace**
    For debugging purposes only: Do not select this choice unless instructed do to so by IBM support.

- **Window**
  This selection always contains the following choices:
  - **Tile**
    This arranges the open windows in a tiled arrangement, that is, all the windows are open and fit side-by-side in the available space.
– Cascade
  This arranges the open windows in a cascaded arrangement, that is, all the windows are placed on top of each other with at least their titles showing.

– Minimize all
  This temporarily hides each open window from view. A button that will redisplay each window appears at the bottom of the main window.

– Maximize all
  This redisplay any windows that were minimized and returns them to view. Each window occupies the entire area of the main window. You can bring any window to the top with its choice in this list.

– Messages
  This redisplay only the Messages window if it was previously minimized and always makes it the active window.

– Sources and repositories
  This redisplay only the Sources and Repositories window if it was previously minimized and always makes it the active window.

This selection also contains an additional entry, by title, for each source or repository window that you currently have open.

– Source - source-title
  This redisplay only the source window named if it was previously minimized and always makes it the active window.

– Repository - repository-title
  This redisplay only the repository window named if it was previously minimized and always makes it the active window.

• Help
  This selection contains the following choices:

  – Getting Started
    This is your online help. It provides brief descriptions to help you understand the contents of the windows and the choices available

  – User's Guide
    This is the Softcopy Librarian User's Guide. It contains a complete description of the Softcopy Librarian.

  – About
    This gives you a brief description of the Softcopy Librarian program and identifies the version.

  – Reporting a problem
    This provides a way to report any problems that you encounter with the Softcopy Librarian directly to IBM.

  – Hints and tips
    This contains suggestions and guidelines from the developers concerning the operation and configuration of Softcopy Librarian.

  – Check for updates (auto and manual)
    This permits you to check the IBM Softcopy Web site for the latest updates to the Softcopy Librarian as they become available.

Using the Softcopy Librarian windows
You will also see several windows in the Softcopy Librarian window.

If your have just installed the Softcopy Librarian: the following windows will appear:
The SCL - Getting Started Window
This is the online help that is available to you from the Help choice on the menu bar. If you no longer need it open all the time, close the Getting Started window, then exit Softcopy Librarian. The program will remember not to open the Getting Started window when you initiate Softcopy Librarian in the future.

The Messages Window
This records status and errors messages as they are produced by the Softcopy Librarian.

The Sources and Repositories Window
This window usually lists all the sources and repositories that are currently available to you. You can open any source or repository listed by double clicking on it in the list. At this point, this window will contain only two default sources - a default CD-ROM drive and a default Internet connection to the IBM Online Library Web site.

The Column Headings in the Sources and Repositories Window: This window lists the following:

- **Type**
  The type of the entry: Source or Repository.
- **Title**
  The titles of the sources and repositories.

**Note:** You can change the alphanumeric order of each column from ascending to descending and back by clicking on the heading of the column that you want to reorder.

The Menu Bar: The menu bar contains the following choices:

- **File**
  This selection contains the following choices:
  - **New**
    This lets you define a new source or repository.
  - **Print**
    This lets you print the list of sources and repositories.
  - **Synchronize** (not available)
    This lets you synchronize or merge the contents of two or more repositories. That is, any file in any repository that is not in any of the other repositories is added to them. All the repositories will be identical to each other.
  - **Open**
    This opens the window of the selected source or repository.
  - **Create Catalog** (Repositories only)
    This creates or recreates the catalog for the selected repository.
  - **Delete**
    This deletes the selected source or repository.
  - **Properties**
    This opens the Repositories Properties - title or the Source Properties - title window for updating the selected source or repository.
  - **Update Status: Compared to** (Sources only)
    This updates the status column for the items on this source in comparison with the contents of one of your repositories.
  - **Erase Cache** (Repositories only)
    This lets you erase the cache if you have made changes to this repository by hand outside of the Softcopy Librarian.
• Help
This selection contains the following choices:
  – Getting Started
    This opens the Getting Started window if it is closed.
  – User's Guide
    This opens the complete Softcopy Librarian User's Guide.

The Source - source-name Window
If you have set up sources or if you have migrated them from a previous version of the Softcopy Librarian, one or more source windows might appear. This window contains a source of publications that you have defined regardless of where it is located. The title that you assigned to it appears in the title of the window. There is one source window for each source to which you currently have access.

You can open a source window by selecting it from the list in the Sources and Repositories window.

The Column Headings in a Source Window: This window lists the following:
• Title
  The titles of the shelves and Knowledge Center content available on this source.
• Status
  The status of each shelf or Knowledge Center .zip file compared to the contents of one of your repositories.

Note: If you do not have any repositories defined, the status is “New.” for all items listed.

The status of a shelf or Knowledge Center .zip file can be:

New  One of the following occurred:
  – This is the first time that this shelf or Knowledge Center .zip file appears on any CD or supported Web site from this manufacturer, and is, therefore, not currently in your repository.

    Note: This status can apply to all IBM CDs and might apply to the CDs of other manufacturer's who take notice of their previous CDs.
  – This shelf appeared on a previous CD; you did not choose to transfer it previously and is, therefore, not currently in your repository.

You can transfer this shelf or Knowledge Center .zip file now.

Updated
  An earlier version of this shelf or Knowledge Center .zip file is currently in your repository. You can transfer this later version now.

    Note: If you upload this later version, it will not automatically replace an earlier version. You can choose to delete the earlier version or keep both versions.

Installed
  This shelf or Knowledge Center .zip file is currently in your repository. You cannot transfer this shelf or Knowledge Center .zip file.

Downlevel
  A later version of this shelf or Knowledge Center .zip file is currently in your repository. This earlier version is not in your repository. You can transfer the earlier version now, if you want it. It will not replace the later version.

    Note: This can happen if the filename of the shelf does not conform to the naming conventions for IBM softcopy files, or if you are currently using a CD that is older than a previous CD from which you transferred this shelf.
Partial  This shelf is currently in your repository. However, your repository is missing one or more files. This is transferrable.

• Filename
  The names of the shelf or Knowledge Center .zip files.
• Date
  The date the shelf or Knowledge Center .zip file was built.
• Size
  The total size of all the files in the shelf or Knowledge Center .zip file in MB (megabytes).
• Files
  The number of files in the shelf.

Note: You can change the alphanumeric order of each column from ascending to descending and back by clicking on the heading of the column that you want to reorder.

The Menu Bar in a Source Window: The menu bar contains the following choices:

• File
  This selection contains the following choices:
  – Print
    This prints a copy of the table that appears in this window.
  – Save As
    This saves to a file a copy of list that appears in this window
  – Update Status: Compare to
    This updates the status of the items on this source in comparison with one of your repositories.
  – Open
    This opens the shelf and displays a list of the associated files (publications) contained in it.
  – Send to
    This lets you send any of the shelves or Knowledge Center .zip files that you have selected to one of your repositories.
  – Refresh
    This refreshes the list if you change sources and automatically does an Update Status to the default repository.
  – Close
    This closes this window.

• Edit
  This selection contains the following choices:
  – Find First
    This lets you search for any text string in the list.
  – Find Next F3
    This finds the next occurrence of the text string.

• Options
  This selection contains the following choices:
  – Select All
    This selects all the items in the list.
  – Deselect All
    This deselects any items that you selected.
  – Show New/Updated   Ctrl+K
    This shows only the items in that list that have a status of “New” or “Updated.”
– Show All
This shows all the items in the list.

The Repository - repository-name Window
If you have set up repositories or if you have migrated them from a previous version of the Softcopy Librarian, one or more repository windows might appear. This window contains one of the repositories that you have defined regardless of its location. The title that you assigned to it appears in the title of the window. There is one repository window for each repository to which you currently have access.

If you had a repository window open previously, it will be open when you start the Softcopy Librarian. You can open a repository window by selecting it from the list in the Sources and Repositories window.

The Column Headings in a Repository Window: This window lists the following:

- Under the Shelves tab:
  - Title
    The titles of the shelves currently in this repository
  
  **Note:** If a shelf appears in “red,” then it is missing one or more associated publication's files.
  - Filename
    The names of the files that contain the shelves.
  - Replaced by
    The filename of a newer version of this shelf that can replace it

- Under the Files tab:
  - Title
    The titles of the shelves and associated publications currently in this repository
  
  **Note:** If a file appears in “red,” then it is missing from one or more shelves.
  - Filename
    The names of the files that contain the shelves and associated publications.
  - Replaced by
    The filename of a newer version of this shelf and associated publications that can replace it.
  - Filetype
    The filetype of this shelf and associated publications.
    Filetypes can be:
    **BOOK**
    Book
    **BKSHELF**
    Shelf
    **XKSHELF**
    Extended Shelf
    **BKINDEX**
    Shelf index
    **PDF**
    PDF file
  - Count
    The reference count of this shelf index and associated publications.
    **Positive**
    Indicates how many shelves currently include these associated publications.
Negative (-)  
Indicates how many shelves are missing these associate publications (shown in red), or  
without an accompanying number indicates a single shelf.

Zero (0)  
Indicates an “orphaned” file that in not part of any shelf.

Note: To save space, repositories managed by the Softcopy Librarian contain only one copy of a  
associated publications that are part of more than one shelf.

• Under the Knowledge Center Content tab:
  – Title  
The titles of the Knowledge Center content currently in this repository
  – Filename  
The names of the .zip files that contain the Knowledge Center content
  – Replaced by  
The filename of a newer version of this .zip file that can replace it
  – Filetype  
The filetype of this content
  Filetypes can be:
    KC .ZIP
    A .zip file that contains Knowledge Center content
    COLLECTION
    A collection of .zip files that contain Knowledge Center content

Note: You can change the alphanumeric order of each column from ascending to descending and back by  
clicking on the heading of the column that you want to reorder.

The Menu Bar in a Repository Window: The menu bar contains the following choices:

Note: These choices apply to both the Shelves and Files tabs unless otherwise indicated.

• Create Catalog - Creates a catalog for the selected repository.

• File
  This selection contains the following choices:
    – Erase Cache  
    This lets you erase the cache if you have made changes to this repository by hand outside of the  
    Softcopy Librarian.
    – Print  
    This prints a copy of the table that appears in this window.
    – Save As  
    This saves to a file a copy of the table that appears in this window
    – Update shelves  
    For z/OS and OS/390 repositories only: If you update a z/OS or OS/390 host repository directly  
    from tape or change it manually, after you make these changes, this updates the data set names in  
    the shelves so the Softcopy Librarian will recognize them. (For users who typically install files from  
    tape, this choice replaces the BKSADD EXEC.) The Update Shelves function is done automatically  
    whenever you run the Create Catalog function.
    – Exclude from Shelf (Files tab only)  
    This excludes missing files from a shelf permanently.

Note: Missing files appear in red in the list of shelves and in the list of files.
- Download from Internet (Files tab only)
  This obtains replacement copies from the IBM Internet Library for any files that are missing from a
  shelf in your repository.
- Delete
  On the Shelves tab: This deletes any shelves that you select.
  On the Files tab: This deletes any file that you select. You should only delete files with a reference
  count of 0 (orphan books).
  If you delete a file with a reference count higher than 0, you will create one or more partial shelves
  that are missing the book you delete.
- Details
  This describes the shelf.
- Edit Title (Shelves tab only)
  This lets you change the title of any of the shelves that appear in this list.
- Open (Shelves tab only)
  This opens the shelf and displays a list of the associated publications in it.
- Send to
  This lets you send any of the shelves or publications that you have selected to one of your
  repositories.
- Close
  This closes this window.

• Edit
  This selection contains the following choices:
  - Find First
    This lets you search for any text string in the list.
  - Find Next F3
    This finds the next occurrence of the text string.

• Options
  This selection contains the following choices:
  - Select All
    This selects all the items in the list.
  - Deselect All
    This deselects any items that you selected.
  - Sort Shelves by Missing Files
    Sorts all shelves with missing files to the top.

What to Do Next
If you have just installed the Softcopy Librarian, and this is the first time that you have started it, you
will need to do the following before you can begin to use it:
• If you want to use the Internet as a source, you must define your Internet connection to the Softcopy
  Librarian. Refer to Chapter 6, “Setting Up Your Connection to the Internet,” on page 23 for instructions.
• If you did not choose to migrate your previous source and repository definitions, but you want to
  continue to use them, you can migrate them at a future time. Refer to Chapter 7, “Migrating from
  Previous Versions of the Softcopy Librarian,” on page 25 for instructions.
• If you want to define new repositories, you must create definitions for them. For instructions, refer to
  Chapter 8, “Setting Up a z/OS or OS/390 Host Repository Using Sequential Data Sets,” on page 27 (for
  repositories in z/OS or OS/390 sequential data sets), Chapter 9, “Setting Up a z/OS or OS/390 Host
  Repository Using the Unix System Services HFS,” on page 33 (in z/OS or OS/390 Unix System
If you have previously **installed the Softcopy Librarian**, and completed all the necessary set up, you are ready to use it. Refer to Chapter 14, “Maintaining Your Repositories,” on page 51 for instructions.
Chapter 6. Setting Up Your Connection to the Internet

This chapter describes how to set up the Softcopy Librarian to connect to the Internet or your intranet. You might want the Softcopy Librarian to be able to use the Internet:

- As a source from the IBM PUBLIB or other Web sites
- To check for and download newer versions of the Softcopy Librarian from IBM.

Note: If you are accessing repositories on hosts or local servers and you not using an intranet or the Internet to access them, you do not need a connection to the Internet. However, if you want to check for updates to the Softcopy Librarian, you will need an Internet connection.

The Softcopy Librarian supports these connections to the Internet:

- Direct connections
  For connections to an intranet inside a firewall or for connections to the Internet without a firewall.

  Recommendation: We strongly recommend that you set up a firewall between your server and the Internet.

- Manual proxy configurations
  - HTTP servers as proxies
  - SOCKS V4 servers as proxies
  For connections to the Internet through a firewall.

- Autoproxy configurations
  For connections to the Internet through a firewall.

Note: If you are connecting to the Internet through a firewall, your server must already be configured for access through your firewall.

Your selection of a type of connection and a URL provided for your proxy should match the specifications in your Web browser.

Note: Please be aware that Softcopy Librarian does not provide user-id/password support when using Proxy Configuration.

Setting Up an Internet Connection

Reminder: You can check for the type of connection you are using as follows:

Start -> Setting -> Control Panel -> Internet Options ->
Connections -> LAN Settings

To set up an Internet connection, do the following:

1. Start the Softcopy Librarian.
2. On the menu bar in the Softcopy Librarian window, select Settings.
3. In the Settings pull-down menu, select Proxies.
   The Proxy Settings window appears.
4. In the Proxy Settings window, do the following:
   a. Select the type of connection. Do one of the following:
      - For a Direct Connection: Select the Direct connection to the Internet button.
• For a Manual Proxy Configuration: Select the Manual proxy configuration button and supply the path to your proxy and a port number.

• For an Auto Proxy Configuration: Select the Auto proxy configuration button and make sure that the URL shown points to the correct automatic configuration script.

b. Click on the OK button.

After you have set up your Internet connection, if needed, you are ready to set up your repositories. You have two possibilities:

• If you are a new user, you are ready to define the repositories that you intend to use. Continue with the instructions in Chapter 8, “Setting Up a z/OS or OS/390 Host Repository Using Sequential Data Sets,” on page 27 (for host repositories using sequential data sets), Chapter 9, “Setting Up a z/OS or OS/390 Host Repository Using the Unix System Services HFS,” on page 33 (for host repositories using hierarchical files), Chapter 10, “Setting Up a Unix-like Repository,” on page 37 (for Unix-like repositories), or Chapter 11, “Setting Up a PC/LAN Repository,” on page 41 (for PC or local repositories).
Chapter 7. Migrating from Previous Versions of the Softcopy Librarian

This chapter describes how to migrate from an older, previous version of the Softcopy Librarian to the most current version. After you install the current version of the Softcopy Librarian, you can migrate your existing repository and source definitions that you used with an older version of the Softcopy Librarian. Migrating these definitions will make them available to the current version of the Softcopy Librarian, and you will not need to redefine them.

Migrating from V4.1 to V4.2

To migrate from V4.1 to V4.2, do the following:
1. Install V4.2
2. Using the Properties function, update each repository adding XKS and PDF information.
3. Initiate an Erase Cache with a Catalog Create for each defined repository.

Migrating from V4.2 to V4.3 or V4.6

IBM Softcopy Librarian V4.2 is not supported on Windows Vista or Windows 7. If you have installed V4.2 on Windows Vista, you need to uninstall V4.2 before you install IBM Softcopy Librarian V4.3. If you have installed V4.2 on Windows 7, you need to uninstall V4.2 before you install IBM Softcopy Librarian V4.6.

File location changes: In IBM Softcopy Librarian V4.3, the sources.fil and repository.fil, both now reside in the output directory. On versions of Microsoft Windows prior to Windows Vista, the default directory for these files was x:\Program Files\IBM\IBM SoftCopy Librarian V5\output where x is the drive where IBM Softcopy Librarian is installed.

On Windows 7 and Windows Vista the default directory for these files is x:\Users\<User ID>\AppData\Roaming\IBM\ibm softcopy librarian\output where x is the drive where IBM Softcopy Librarian is installed.

For earlier versions of Windows, the sources.fil and repository.fil files were written to the Program Files directory, but on Windows 7 and Windows Vista, the Program Files directory is read only by default.

Migrating from V4.3 or V4.6 to V5.0

Procedure

To migrate from V4.3 or V4.6:
1. Install Softcopy Librarian V5.0.
2. Using the Properties function, update existing or add new repositories, adding kcContent and kcProperties information.
3. Run the Erase Cache and Catalog Create functions for each defined repository.
Chapter 8. Setting Up a z/OS or OS/390 Host Repository Using Sequential Data Sets

You must define at least one host repository for the Softcopy Librarian to be able to manage your softcopy files. You can set up one or more host repositories using z/OS or OS/390 sequential data sets. This type of repository is intended for use with BookManager READ/MVS accessed from a 3270-like terminal or through a 3270-like emulator session from a workstation. The definition for this type of repository tells the Softcopy Librarian where to look for the shelves and what FTP commands to use to access the repository. You can define this type of repository whether or not you already have softcopy files installed on your host.

This chapter describes:

- Considerations to keep in mind before setting up your repository
- Instructions for preparing your host
- Defining the repository to the Softcopy Librarian

Considerations for Setting Up Your Repository Using Sequential Data Sets

Here are some things you need to know about repositories on a z/OS or OS/390 host in sequential data sets:

- You can define your repositories in several ways. For example:
  - Define a single repository under one HLQ, into which you would put all your softcopy data sets.
  - Define a single repository under multiple HLQs.
    You can put your softcopy
    - All shelf file types must be under the same HLQ.
    - File types can be either under a separate HLQ or combined under an HLQ.
  - Define multiple repositories, provided they are each under separate HLQs from each other.

- If you already have a shelf or shelves (.BKSHELF and .XKSHELF) data sets for a repository installed under multiple HLQs, you must delete them and reinstall them under a single HLQ.

- You can place non-softcopy items under HLQs managed by the Softcopy Librarian. The Softcopy Librarian will ignore them.

- If you add or remove softcopy items from your repository without using the Softcopy Librarian, you must recreate the catalog.
  The Softcopy Librarian will not recreate it automatically for you, and, therefore, it will not be able to recognize your changes.

- The Softcopy Librarian creates a shelf list in the HLQ you specify when you set up your repository. Do not make any changes to this list. This list is replaced whenever the Softcopy Librarian adds or removes data sets, so your changes will be lost.

Setup Required at Your z/OS or OS/390 Host

To set up a repository on your host, you must do the following:
1. Edit the BookManager Shelf list (.BKLSHELF) on your host. Do the following:
   a. Make a backup copy of your BookManager Shelf list (the default is EOY.BKLSHELF).
   b. Edit the original copy of the EOY.BKLSHELF Shelf list.
   c. Delete any shelves that you want the Softcopy Librarian to manage.
d. Include an entry for the Softcopy Librarian's Shelf list:

```
INCLUDE hlq.BKLSHELF
```

2. **For System Managed Storage Users:** You can define separate storage classes for the data sets containing shelves and associated publications. However, ensure that the Shelf data sets in your host repository are **not** migrated from DASD to tape.

**Note:** If you do migrate your data sets to tape, you must issue an HRECALL command to recall the data sets before you attempt to create your catalog.

You are now ready to define a host repository. Continue with the instructions in "Defining a z/OS or OS/390 Host Repository."

---

### Defining a z/OS or OS/390 Host Repository

To define a host repository, do the following:

1. **On your workstation,** start the Softcopy Librarian. (Refer to Chapter 5, “Starting the Softcopy Librarian,” on page 13.)

2. In the Sources and Repositories window in the Softcopy Librarian window, do the following:
   a. Click on File on the task bar.
   b. In the pull-down window that appears, click on the New choice.
   c. In the pop-up window that appears, click on the Repository choice.
   The Repository Properties - New Repository window appears.

3. In the Repository Properties - New Repository window, do the following:
   a. Type a name for this new repository in the Repository Title field.
   b. Select the **Location and method of accessing** your repository.
      - z/OS or OS/390 - Sequential Data Sets via FTP
        This is the default.
   c. Click on the FTP Logon Information tab or the Next> button.
   The FTP logon information window appears.

4. In the FTP logon information window, do the following:
   a. In the Host: field, type the host name or IP address of your host.
   b. In the Port: field, type a port number, if you know that you must use a non-standard port number to connect to your host. Otherwise, leave this field blank.
   c. In the UserID field, type your user ID on your host.
   d. In the Password field, type your password for this host, if you have a password.
   e. Optionally, Click on the Save Password box.
      By saving your password, you will not need to enter your password whenever you start the Softcopy Librarian. If you do not save your password, you must enter it every time you start the Softcopy Librarian.
   f. In the FTP site commands field, enter defaults for any other type FTP site commands that your installation requires. Enter a complete command, for example:
      ```
      SITE DCB=xxx
      ```
      These site commands are typically used for allocating data sets. Type one command per line.
   g. Click on the File types tab or the Next> button.
      The File types window appears.

5. In the File types window, do the following:
a. If you want to set the same defaults for your SMS classes, DASD units and volumes, or additional FTP commands that apply to all file types, Select the **DEFAULT - Applies to all filetypes** choice from the list at the top of the window.

**Note:** All defaults are optional. If you do not provide a value for of any of the items in this window except SMS classes, no defaults will be set. For SMS classes, if you do not set a default here, any host settings that are in effect will be used.

If you specify any of these values for the BOOK, BKINDEX, BKSHELF, or Bklshelf choices, those values will override the defaults you set here for the DEFAULT choice.

If you do not want to set the same defaults for your SMS classes, DASD units or volumes, or additional FTP commands that will apply to all file types, continue with the next step.

b. In the SMS Data Class field, enter a data class for all file types.

c. In the SMS Management Class field, enter a management class for all file types.

d. In the SMS Storage Class field, enter a storage class.

e. In the Unit field, enter a default DASD device for your high-level qualifiers.

f. In the Volume field, enter a default volume ID for your high-level qualifiers.

g. In the Additional FTP commands field, enter any additional FTP commands.

h. Continue with the next step to define the high-level qualifiers and blocksizes for your repository and any defaults that you want to apply only BOOK files.

6. Click on the Book choice in pull-down list or the **Next** button.

7. Do the following:

   a. Required: In the High-level qualifier field, type one or more high-level qualifiers for the books in your repository.

   You do not need to include single quotes; they will be provided for you, for example, if you type:

   | library.libbooks |
   | library.ourbooks |

   It will appear as:

   | 'library.libbooks' |
   | 'library.ourbooks' |

   b. **Required:** In the Blocksize pull-down menu, select the blocksize for the DASD device you are using for your BOOK data sets.

   c. **Optional:** If you want to assign separate defaults for SMS classes, devices, or FTP site commands for your BOOK data sets, you can specify values in the remaining fields on this tab. Otherwise, the defaults that you specified for the DEFAULT choice will be used for these data sets.

8. Click on the BKINDEX choice in pull-down list or the **Next** button.

9. Do the following:

   a. **Required:** In the High-level qualifier field, type the high-level qualifier for the shelf indexes in your repository.

   You do not need to include single quotes; they will be provided for you, for example, if you type:

   | library.ibmindex |

   It will appear as:

   | 'library.ibmindex' |

   **Note:** Make sure that the data sets under this high-level qualifier contains only softcopy items.

   b. **Required:** In the Blocksize pull-down menu, select the blocksize for the DASD device you are using for your BKINDEX data sets.

   c. **Optional:** If you want to assign separate defaults for SMS classes, devices, or FTP site commands for your BKINDEX data sets, you can specify values in the remaining fields on this tab. Otherwise, the defaults that you specified for the DEFAULT choice will be used for these data sets.
10. Click on the BKSHELF choice in pull-down list or the Next button.

11. Do the following:
   a. **Required:** In the High-level qualifier field, type the high-level qualifier for the shelves in your repository.
      You do not need to include single quotes; they will be provided for you, for example, if you type:
      `library.ibmshelf`
      It will appear as:
      `'library.ibmshelf'`
   b. **Required:** In the Blocksize pull-down menu, select the blocksize for the DASD device you are using for your BKSHELF data sets.
   c. **Optional:** If you want to assign separate defaults for SMS classes, devices, or FTP site commands for your BKSHELF data sets, you can specify values in the remaining fields on this tab. Otherwise, the defaults that you specified for the DEFAULT choice will be used for these data sets.

12. Click on the BKLSHELF choice or the Next button.

13. Do the following:
   a. **Required:** In the HLQ field, provide the high-level qualifier for the shelf list that you included in EOY.BKLSHELF.
   b. **Optional:** If you want to assign separate SMS classes, devices, or FTP site commands for your shelf list data set, you can specify values for the remaining fields on this tab. Otherwise, the defaults that you specified on the DEFAULT choice will be used for this data set.

14. Click on the PDF choice in pull-down list or the Next button.

15. Do the following:
   a. **Required:** In the High-level qualifier field, type one or more high-level qualifiers for the PDFs in your repository.
      You do not need to include single quotes; they will be provided for you, for example, if you type:
      `library.ibmPDFs`
      It will appear as:
      `'library.ibmPDFs'`
   b. **Required:** In the Blocksize pull-down menu, select the blocksize for the DASD device you are using for your PDF data sets.
   c. **Optional:** If you want to assign separate defaults for SMS classes, devices, or FTP site commands for your PDF data sets, you can specify values in the remaining fields on this tab. Otherwise, the defaults that you specified for the DEFAULT choice will be used for these data sets.

16. Click on the XKSHELF choice in pull-down list or the Next button.

17. Do the following:
   a. **Required:** In the High-level qualifier field, type the high-level qualifier for the shelves in your repository.
      You do not need to include single quotes; they will be provided for you, for example, if you type:
      `library.ibmxks`
      It will appear as:
      `'library.ibmxks'`
   b. **Required:** In the Blocksize pull-down menu, select the blocksize for the DASD device you are using for your XKSHELF data sets.
   c. **Optional:** If you want to assign separate defaults for SMS classes, devices, or FTP site commands for your XKSHELF data sets, you can specify values in the remaining fields on this tab. Otherwise, the defaults that you specified for the DEFAULT choice will be used for these data sets.

18. Click on the OK button.

   The Softcopy Librarian window reappears with the following changes:
The Sources and Repositories window now lists the repository that you just defined.

A new Repository - repository-name window for the repository will not appear, but you can open it from the Sources and Repositories window.

You are done defining your repository. You can define additional repositories by repeating these instructions for each new repository.

When you have finished defining all your repositories, you are ready to create the catalog for your repositories. Continue with the instructions in Chapter 12, “Creating and Recreating the Catalog for Your Repository,” on page 45.
Chapter 9. Setting Up a z/OS or OS/390 Host Repository Using the Unix System Services HFS

You must define at least one repository for the Softcopy Librarian to be able to manage your softcopy files. You can set up one or more host repositories of softcopy files using the hierarchical file system of z/OS or OS/390 Unix System Services. This type of repository is intended for use with either:

- BookManager BookServer/Library Server accessed from a workstation through a web browser
- IBM Knowledge Center for z/OS content accessed from a workstation through a web browser

The definition for this type of repository tells the Softcopy Librarian where to look for the softcopy shelves and what FTP commands to use to access the repository. You can define this type of repository whether or not you already have softcopy installed on your host.

This chapter describes:

- Considerations to keep in mind before setting up your repository
- Information about your repository that you will need when you set up the Softcopy Librarian on your workstation
- Instructions for preparing your host
- Defining the repository to the Softcopy Librarian

Considerations for Setting Up a Repository in Hierarchical Files

Here are some things you need to know about repositories in the z/OS or OS/390 Unix System Services hierarchical files:

- You can define your repositories in several ways. For example:
  - Define a single repository in a single directory, into which you would put all your content and associated publications.
  - Define a single repository in multiple directories.
    - All file types must be in the same directory.
    - File types can be either in separate directories or in combined directories.
  - Define multiple repositories, provided they are each in separate directories from each other.
- If you already have Shelf (.xks) files for a repository installed in multiple directories, you must delete them and reinstall them in a single directory.
- If you add or remove softcopy items from your repository without using the Softcopy Librarian, you must recreate the catalog.
  The Softcopy Librarian will not recreate it automatically for you, and, therefore, it will not be able to recognize your changes.
- File names for softcopy items are transferred by the Softcopy Librarian in lower case.

Information You Must Gather about Your Repository

You must provide the following information when you define the repository:

- A name by which the repository will be known on your workstation.
- The host name or IP address and your host user ID and password.
- One or more directories that will contain the files.
- Any FTP commands are required by your location to transfer the associated file types from the workstation to your host.
Defining a z/OS or OS/390 UNIX System Services Host Repository

To define a host repository, do the following:

1. On your workstation, start the Softcopy Librarian. (Refer to Chapter 5, “Starting the Softcopy Librarian,” on page 13.)
2. In the Sources and Repositories window in the Softcopy Librarian window, do the following:
   a. Click on File on the task bar.
   b. In the pull-down window that appears, click on the New choice.
   c. In the pop-up window that appears, click on the Repository choice.
   The Repository Properties - New Repository window appears.
3. In the Repository Properties - New Repository window, do the following:
   a. Type a name for this new repository in the Repository Title field.
      Note: The name you type here can be anything you want. It is the name that the Softcopy Librarian uses on your workstation to refer to your host repository.
   b. Select the Location and method of accessing your this repository by clicking on the z/OS or OS/390 - Unix System Service HFS via FTP button.
   c. Click on the FTP Logon Information tab or the Next button.
   The FTP logon information window appears.
4. In the FTP logon information window, do the following:
   a. In the Host: field, type the host name or IP address of your host.
   b. In the Port: field, type a port number, if you know that you must use a non-standard port number to connect to your host. Otherwise, leave this field blank.
   c. In the UserID field, type your user ID on your host.
   d. In the Password field, type your password for this host, if you have a password.
   e. Optionally, click on the Save Password box.
      By saving your password, you will not need to enter your password whenever you start the Softcopy Librarian. If you do not save your password, you must enter it every time you start the Softcopy Librarian.
   f. In the FTP site commands field, enter defaults for any other type FTP site commands that your installation requires. Enter a complete command, for example:
      SITE DCB=xxx
      These site commands are typically used for allocating data sets. Type one command per line.
   g. Click on the File types tab or the Next button.
      The File types window appears.
5. In the File types window, do the following:
6. Click on the BOO choice pull-down list or the Next button.
   a. Required: In the Directories containing books field, type the path to the directory in your HFS that contains your books. For example:
      /u/your-ID/books
7. Click on the BKI choice in pull-down list or the Next button.
   a. Required: In the Directory containing indexes field, type the path to the directory in your HFS that contains your indexes. For example:
      /u/your-ID/indexes
      Note: This can be the same directory that contains your books.
8. Click on the BKS choice in pull-down list or the Next button.
   a. In the Directory containing shelves field, type the path to the directory in your HFS that contains your shelves. For example:
      
      /u/your-ID/shelves
   b. Click on the OK button.

9. Click on the PDF choice pull-down list or the Next button.
   a. Required: In the Directories containing PDFs field, type the path to the directory in your HFS that contains your books. For example:
      
      /u/your-ID/PDFs

10. Click on the XKS choice in pull-down list or the Next button.
    a. In the Directory containing shelves field, type the path to the directory in your HFS that contains your XKS shelves. For example:
       
       /u/your-ID/xkshelves
    b. Click on the OK button.

11. If you are setting up the repository for use with IBM Knowledge Center for z/OS, click on the kcCONTENT choice in pull-down list or the Next button.
    a. In the Directories containing KC PLUGIN CONTENT field, type the paths to the directories in your HFS that will contain your Knowledge Center plugins. For example:
       
       /u/your-ID/kccontent

       The Knowledge Center plugins you are deploying are either directories or .jar files, depending on the style in which they had been packaged by the content builder. They will be located in a subdirectory of the directory specified in this field. The subdirectory name is determined by Softcopy Librarian based on the name of the collection to which these plugins belong.
    b. Click on the OK button.

12. If you are setting up the repository for use with IBM Knowledge Center for z/OS, click on the kcPROPERTIES choice in pull-down list or the Next button.
    a. In the Directory containing KC PRODUCT PROPERTIES field, type the path to the directory in your HFS that will contain your Knowledge Center product .properties files. For example:
       
       /u/your-ID/kcproperties

       You must enter only one directory.
    b. Click on the OK button.

The Softcopy Librarian window reappears with the following changes:

- The Sources and Repositories window now lists the repository that you just defined.
- A new Repository - repository-name window appears with the name you assigned.

You are done defining your repository. You can define additional repositories by repeating these instructions for each new repository.

When you have finished defining all your repositories, you are ready to create the catalog for your repositories. Continue with the instructions in Chapter 12, “Creating and Recreating the Catalog for Your Repository,” on page 45.
Chapter 10. Setting Up a Unix-like Repository

You must define at least one repository for the Softcopy Librarian to be able to manage your softcopy files. This type of repository is intended for use with BookManager BookServer accessed from a workstation through a Web browser. The repository definition tells the Softcopy Librarian where to look for softcopy and what FTP commands to use to access the repository. You can define a repository whether or not you already have softcopy files installed.

This chapter describes:
• Considerations to keep in mind before setting up your repository
• Defining the repository to the Softcopy Librarian

Considerations for Setting Up Your Repository

Here are some things you need to know about your repository on UNIX server hard drives:
• You can define your repositories in several ways. For example:
  – Define a single repository in a single directory, into which you would put all your softcopy files.
  – Define a single repository in multiple directories.
    - All shelf file types must be in the same directory.
    - File types can be either in separate directories or in combined directories.
  – Define multiple repositories, provided they are each in separate directories from each other.
• Ensure you have read/write access to the necessary directories.
• If you already have files for a repository installed in multiple directories, you must delete them and reinstall them in a single directory.
• If you add or remove softcopy items from your repository without using the Softcopy Librarian, you must recreate the catalog.
  The Softcopy Librarian will not recreate it automatically for you, and, therefore, it will not be able to recognize your changes.

Defining a Unix Server Repository

To define a repository on a Unix server, do the following:
1. On your workstation, start the Softcopy Librarian. (Refer to Chapter 5, “Starting the Softcopy Librarian,” on page 13.)
2. In the Sources and Repositories window in the Softcopy Librarian window, do the following:
   a. Click on File on the task bar.
   b. In the pull-down window that appears, click on the New choice.
   c. In the pop-up window that appears, click on the Repository choice.
   The Repository Properties - New Repository window appears.
3. In the Repository Properties - New Repository window, do the following:
   a. Type a name for this new repository in the Repository Title field.

   Note: The name you type here can be anything you want. It is the name that the Softcopy Librarian uses on your workstation to refer to your repository.
   b. Select the Location and method of accessing your this repository by clicking on Other UNIX-like via FTP button.
   c. Click on the FTP Logon Information tab or the Next> button.
The FTP logon information window appears.

4. In the FTP logon information window, do the following:
   a. In the Host: field, type the IP address of your server.
   b. In the Port: field, type a port number, if you know that you must use a non-standard port number to connect to your server. Otherwise, leave this field blank.
   c. In the UserID field, type your user ID on your server.
   d. In the Password field, type your password for this server.
   e. Optionally, click on the Save Password box.
      By saving your password, you will not need to enter your password whenever you start the Softcopy Librarian. If you do not save your password, you must enter it every time you start the Softcopy Librarian.
   f. In the FTP site commands field, enter defaults for any other type FTP site commands that your installation requires. Enter a complete command, for example:
      SITE DCB=xxx
      These site commands are typically used for allocating data sets. Type one command per line.
   g. Click on the File types tab or the Next> button.
      The File types window appears.

5. In the File types window, click on the 800 choice in the pull-down list or the Next button. In the Directories containing books field, type the one or more paths to the directory that contain your books. For example:
   /u/your-ID/books

6. Click on the BKI choice in the pull-down list or the Next button. In the Directory containing indexes field, type the path to the directory that contains your indexes. For example:
   /u/your-ID/indexes

   Note: This can be the same directory that contains your books.

7. Click on the BKS choice in the pull-down list or the Next button. Do the following.
   a. In the Directory containing shelves field, type the path to the directory that contains your shelves. For example:
      /u/your-ID/shelves
   b. Click on the OK button.

8. Click on the PDF choice in the pull-down list or the Next button. In the Directories containing PDFs field, type the one or more paths to the directory that contain your PDFs. For example:
   /u/your-ID/PDFs

9. Click on the XKS choice in the pull-down list or the Next button. Do the following:
   a. In the Directory containing extended shelves field, type the path to the directory that contains your extended shelves. For example:
      /u/your-ID/xkshelves
   b. Click on the OK button.

10. If you are setting up the repository for use with Knowledge Center content, click on the kcCONTENT choice in pull-down list or the Next button.
    a. In the Directories containing KC PLUGIN CONTENT field, type the paths to the directories in your HFS that will contain your Knowledge Center plugins. For example:
       /u/your-ID/kccontent

       The Knowledge Center plugins you are deploying are either directories or .jar files, depending on the style in which they had been packaged by the content builder. They will be located in a subdirectory of the directory specified in this field. The subdirectory name is determined by Softcopy Librarian based on the name of the collection to which these plugins belong.
b. Click on the OK button.

11. If you are setting up the repository for use with Knowledge Center content, click on the kcPROPERTIES choice in pull-down list or the Next button.
   a. In the Directory containing KC PRODUCT PROPERTIES field, type the path to the directory in your HFS that will contain your Knowledge Center product .properties files. For example: /u/your-ID/kcproperties

       You must enter only one directory.
   b. Click on the OK button.

The Softcopy Librarian window reappears with the following changes:
• The Sources and Repositories window now lists the repository that you just defined.
• A new Repository - repository-name window appears with the name you assigned.

You are done defining your repository. You can define additional repositories by repeating these instructions for each new repository.

When you have finished defining all your repositories, you are ready to create the catalog for your repositories. Continue with the instructions in Chapter 12, “Creating and Recreating the Catalog for Your Repository,” on page 45.
Chapter 11. Setting Up a PC/LAN Repository

You must define at least one repository for the Softcopy Librarian to be able to manage your softcopy files. This type of repository is intended for use with BookManager BookServer accessed from a workstation through a Web browser. The repository definition tells the Softcopy Librarian where to look for softcopy. You can define a repository whether or not you already have bookshelves and books installed.

This chapter describes:

- Considerations to keep in mind before setting up your repository
- Instructions for preparing your PC or LAN server
- Defining the repository to the Softcopy Librarian

Considerations for Setting Up Your Repository

Here are some things you need to know about your repository on LAN server or PC hard drives:

- You can define your repositories in several ways. For example:
  - Define a single repository in a single directory, into which you would put all your softcopy files.
  - Define a single repository in multiple directories.
    - All the shelf file types must be in the same directory.
    - File types can be either in separate directories or in combined directories
  - Define multiple repositories, provided they are each in separate directories from each other.
- If you already have files for a repository installed in multiple directories, you must delete them and reinstall them in a single directory.
- If you add or remove softcopy items from your repository without using the Softcopy Librarian, you must recreate the catalog.
  The Softcopy Librarian will not recreate it automatically for you, and, therefore, it will not be able to recognize your changes.

Setup Required for Your Repository

If the repository is on a LAN, ensure you have read/write access to the necessary directories.

Defining a PC or LAN Server Repository

To define a repository on a PC or LAN server, do the following:

1. On your workstation, start the Softcopy Librarian. (Refer to Chapter 5, “Starting the Softcopy Librarian,” on page 13.)
2. In the Sources and Repositories window in the Softcopy Librarian window, do the following:
   a. Click on File on the task bar.
   b. In the pull-down window that appears, click on the New choice.
   c. In the pop-up window that appears, click on the Repository choice.
   The Repository Properties - New Repository window appears.
3. In the Repository Properties - New Repository window, do the following:
   a. Type a name for this new repository in the Repository Title field.

   Note: The name you type here can be anything you want. It is the name that the Softcopy Librarian uses on your workstation to refer to your repository.
b. Select the **Location and method of accessing** for this repository by clicking on the **Local or network drive via COPY commands** button.

c. Click on the File types tab or the **Next>** button.

The File types window appears.

4. In the **file types** window, do the following:

5. Click on the **B00** choice in the pull-down list or the **Next** button. Do the following:

   a. **Required:** In the **Directories containing books** field, type the one or more paths to the directory that contain your books. For example:

       \u\your-ID\books

6. Click on the **BKI** choice in the pull-down list or the **Next** button. Do the following:

   a. **Required:** In the **Directory containing indexes** field, type the path to the directory that contains your indexes. For example:

       \u\your-ID\indexes

   **Note:** This can be the same directory that contains your books.

7. Click on the **BKS** choice in the pull-down list or the **Next** button. Do the following:

   a. In the **Directory containing shelves** field, type the path to the directory that contains your bookshelves. For example:

       \u\your-ID\shelves

   b. Click on the **OK** button.

8. Click on the **PDF** choice in the pull-down list or the **Next** button. Do the following:

   a. **Required:** In the **Directories containing PDFs** field, type the one or more paths to the directory that contain your PDFs. For example:

       \u\your-ID\PDFs

9. Click on the **XKS** choice in the pull-down list or the **Next** button. Do the following:

   a. In the **Directory containing extended shelves** field, type the path to the directory that contains your extended shelves. For example:

       \u\your-ID\xkshelves

   b. Click on the **OK** button.

10. If you are setting up the repository for use with Knowledge Center content, click on the **kcCONTENT** choice in pull-down list or the **Next** button.

   a. In the **Directories containing KC PLUGIN CONTENT** field, type the paths to the directories in your HFS that will contain your Knowledge Center plugins. For example:

       /u/your-ID/kccontent

       The Knowledge Center plugins you are deploying are either directories or .jar files, depending on the style in which they had been packaged by the content builder. They will be located in a subdirectory of the directory specified in this field. The subdirectory name is determined by Softcopy Librarian based on the name of the collection to which these plugins belong.

   b. Click on the **OK** button.

11. If you are setting up the repository for use with Knowledge Center content, click on the **kcPROPERTIES** choice in pull-down list or the **Next** button.

   a. In the **Directory containing KC PRODUCT PROPERTIES** field, type the path to the directory in your HFS that will contain your Knowledge Center product .properties files. For example:

       /u/your-ID/kcproperties

       You must enter only one directory.

   b. Click on the **OK** button.

The Softcopy Librarian window reappears with the following changes:
The Sources and Repositories window now lists the repository that you just defined.
A new Repository - repository-name window appears with the name you assigned.

You are done defining your repository. You can define additional repositories by repeating these instructions for each new repository.

When you have finished defining all your repositories, you are ready to create the catalog for your repositories. Continue with the instructions in Chapter 12, “Creating and Recreating the Catalog for Your Repository,” on page 45.
Chapter 12. Creating and Recreating the Catalog for Your Repository

This chapter describes:
• How the Softcopy Librarian updates the catalog for your repository automatically when you use it to:
  – Transfer softcopy files to the repository
  – Perform routine maintenance on your repository.
• When and how you must erase the cache that the Softcopy Librarian uses
• How you must create or recreate the catalog manually for your repositories after you:
  – Set up the repository for the first time
  – Make manual changes to the contents of your repositories
    For example, you might have:
    - Unloaded shelves, books, and indexes from tape directly into your repository
    - Copied softcopy files manually into your repository
    - Deleted softcopy files manually from your repository
  – Change the definition of a repository
  – Erased the cache used by the Softcopy Librarian
  – Receive certain errors that can cause a mismatch between the catalog and its repository.

Note: If you haven't already defined a repository on your host, you must define one before you can create a catalog for it. Refer to Chapter 8, “Setting Up a z/OS or OS/390 Host Repository Using Sequential Data Sets,” on page 27, Chapter 9, “Setting Up a z/OS or OS/390 Host Repository Using the Unix System Services HFS,” on page 33, Chapter 10, “Setting Up a Unix-like Repository,” on page 37, or Chapter 11, “Setting Up a PC/LAN Repository,” on page 41 for instructions before you continue.

If you are creating a catalog for the first time or recreating it after you have made manual changes to your repository, you can continue with the instructions in “Creating or Recreating the Catalog Manually” on page 46.

If you are routinely transferring Knowledge Center content or shelves and associated publications to your repository or maintaining it, refer to “Updating Your Catalog Automatically.”

Updating Your Catalog Automatically

After you have set up your repository and created its catalog for the first time, you are ready to transfer content routinely as you receive them on CDs or as they appear on the IBM Web site.

When you transfer content using the Softcopy Librarian, the catalog is updated automatically to reflect the changes the transfer made to the repository. You do not need to recreate the catalog. For routine transfers to your repositories, refer to Chapter 14, “Maintaining Your Repositories,” on page 51 for instructions.

When you maintain your repositories using the Softcopy Librarian, the catalog is also updated automatically for you. You do not need to recreate it. The Softcopy Librarian allows deletion of old and out-dated files from your repositories. For day-to-day maintenance of your host repository, refer to Chapter 14, “Maintaining Your Repositories,” on page 51 for more information.
Creating or Recreating the Catalog Manually

There are times when you must create or recreate a catalog manually for your repositories:
• If you are creating a catalog for the first time
• If you have made any manual changes to your repository or its contents.

To create a catalog for your new host repository or to recreate it, do the following:
1. On your workstation, start the Softcopy Librarian.
2. In the Sources and Repositories window, do the following:
   a. Select the repository for which you want to recreate its catalog.
   b. Select the File option on the task bar.
   c. In the File menu, Select the Create catalog.

   The creation of the catalog may take quite a while if there are many files in the repository. As the catalog is created or recreated, you will see several messages appear in the Softcopy Librarian Messages window. The ones you may notice are:

   125 List started OK.
   ... Analyzing directory ...

   The following set of messages appear for each shelf that is processed:

   Processing shelf 0000 dataset-name ...
   ... Adding shelf filename to catalog

   A pop-up window appears with a message that the catalog has been created.
3. Click on the OK button.

   The catalog is created and the Softcopy Librarian window reappears.

In general, catalog creation:
• Lists in the catalog all files specified by the high-level qualifiers and directories.
• Reads the files to determine their contents.
  Each time an index file is used in a shelf, the reference count for that file is incremented by 1. A file’s reference count indicates how many shelves contain that file.
• Writes into the catalog, the list of files, and other information that is stored on the workstation.
• For OS/390 Sequential Data Sets Only: Creates a shelf list (BKLSHELF data set) and stores it on the host using the high-level qualifier you specified. This list contains the names of all the shelves that are being managed by the Softcopy Librarian.

After you have created or recreated the catalog for your repository, you should define a default location from which you will be transferring softcopy files. Refer to the instructions in Chapter 13, “Identifying the Sources of Content That You Want to Transfer,” on page 49.

When and How to Erase the Cache That the Softcopy Librarian Uses

A copy of each of your shelves or Knowledge Center .zip files is kept in the cache directory on your workstation. When the Softcopy Librarian reads a shelf or Knowledge Center content, it reads it from the cache directory rather than transferring it from the repository. This saves accessing time.

If changes are made to the shelf or Knowledge Center content files in your repository, you must also erase the cache that the Softcopy Librarian uses and then recreate the catalog for the repository. Otherwise, the Softcopy Librarian will not be aware of the changes made and will read an older copy from the cache. These changes include:
• Editing a Shelf file to change the title.

  Note: If you want to edit the title of the Shelf, you should use the Edit Title choice under the Edit option in the Shelf view.

• Rebuilding the Shelf without changing its file name

To help the Softcopy Librarian keep track of these changes, do the following:
1. Start the Softcopy Librarian.
2. In the Sources and Repositories window, do the following:
   a. Select the repository you modified.
   b. Select the File option on the task bar.
   c. In the File menu, select Erase cache.
   d. Select the File option again on the task bar.
   e. In the File menu, select Create catalog.
Chapter 13. Identifying the Sources of Content That You Want to Transfer

Before you can transfer softcopy to your repository for the first time, you must identify their source to the Softcopy Librarian. This chapter describes how to identify the sources from which you plan to transfer to your repositories routinely. The Softcopy Librarian lets you define any of the following sources, which you can change at any time. You can define:

- A CD-ROM drive (for transferring from CD collections)
- An Internet Web site that supports the Softcopy Librarian (for transferring from IBM PUBLIB and other Web sites)
- A LAN server hard drive (for transferring softcopy that was created or collected by various means)
- A local PC hard drive (for transferring softcopy that you created).

Note: Transferring from an Internet site is only available from Windows workstations, it is not available with OS/2 workstations.

Use the Softcopy Librarian's Automatic check for updates function. This is available from the Softcopy Librarian, choice in the Start menu or in the Softcopy Librarian’s Help. With this, you should be able to download from the Internet.

Identifying a CD Reader or Hard Drive as the Source

To identify a source from which you want to transfer, do the following:

1. On your workstation, start the Softcopy Librarian.
2. In the Sources and Repositories window, do the following:
   a. Click the File choice on the task bar.
   b. In the File menu, click New.
   c. In the New menu, click Source.
      The Source Properties - New Source window appears.
3. In the Source Properties - New Source window, do the following:
   a. Type a name in the Source title field.
      This can be any name you choose. The Softcopy Librarian uses this name to identify this source on your workstation.
   b. Identify the type of the source you want to use. Do one of the following:
      • If you want to use a CD-ROM or hard drive as a source, select the Install softcopy from a CD or hard drive button, supply the path to the drive in the Softcopy file path field.
      • If you want to use an Internet site as a source, select the Install softcopy files from the Internet button, and supply the URL of the Internet site in the URL address of Internet site field. The default URL (http://publib.boulder.ibm.com) shown is the address of the IBM PUBLIB Web site.

Note: We do not generally recommend that you routinely use a web site to maintain your repositories. Depending upon the speed of your Internet access, downloading can take substantially longer than transferring from CDs or a local hard drive.

If your Internet access is relatively slow, we recommend that you continue to use the IBM CD collections to set up your repositories initially and for your normal quarterly refreshes, and use the Internet only as follows:
- Between quarters to obtain any softcopy files that might have missed the collections.
- Near the end of the quarter to obtain a few critical softcopy files early prior to their release on the CD collections.
- If you do not have access to the CD collections.

If you have high-speed Internet access, you can try maintaining your repositories each quarter from a web site.

c. Click the OK button.

You are now ready to transfer from your CD reader, a hard drive, or the Internet to your repository. Continue with the instructions in Chapter 14, “Maintaining Your Repositories,” on page 51.
Chapter 14. Maintaining Your Repositories

This chapter describes how to transfer content to your repositories and maintain them.

You can:
- Maintain one or more repositories separately
  You can transfer new and updated softcopy files to each repository and manually delete from each repository files that have newer replacements.
- Maintain one repository and several identical copies
  If you need to create and maintain several identical repositories, you can transfer to one repository and maintain it as a model. Then you can transfer files to one or more repositories independently of each other, maintain them separately, but “synchronize” their contents.

Transferring Content to a Repository

You can add or update shelves or Knowledge Center for z/OS content to your repository by transferring it from your SoftCopy Librarian sources. You can update your repositories separately. This means you must go to each repository and make any changes that you want.

Before you begin

If you have not defined the sources or repositories that you intend to use, refer to the instructions in Chapter 13, “Identifying the Sources of Content That You Want to Transfer,” on page 49 to define your sources or Chapter 8, “Setting Up a z/OS or OS/390 Host Repository Using Sequential Data Sets,” on page 27, Chapter 9, “Setting Up a z/OS or OS/390 Host Repository Using the Unix System Services HFS,” on page 33, Chapter 10, “Setting Up a Unix-like Repository,” on page 37, or Chapter 11, “Setting Up a PC/LAN Repository,” on page 41 to define your repositories before you can continue. After you have defined your sources and repositories, return here and continue with these instructions.

About this task

To begin the process of maintaining a repository, you should decide when it is appropriate to transfer to a repository. You could choose to update a repository when you:
- Receive a new CD-ROM collection
- Notice that new or updated versions of softcopy files appear on your source Internet site

Procedure

To transfer content to a repository:
1. If you are using a CD-ROM source, insert the correct CD in your CD reader.
2. Start the SoftCopy Librarian. The Source and Repositories window opens. If you had previously opened any of your source or repository windows, those windows will also be open.
3. Select the source from which you want to update your repository.
   - If the source window you want is not already open, you can select it from the Sources and Repositories window by double-clicking on the source you want to open or single-clicking on the source you want to open and selecting Open from the File menu on the task bar. The SCL Repository List window will appear with a list of your current repositories.
   - Alternatively, in the SCL Repository List window, select the repository that you want to update from the source selected. The SoftCopy Librarian will compare the contents of the source you selected with the repository you select in this window and will update the status of the items in the...
source. The updated status in the source window will indicate which items are potential candidates for updating the repository. The source window you selected will open with an updated status.

- If your source window is already open, then in the Source - Title window, select **Update Status: Compared to** from the File menu. Select the repository that you want to update from the list of your current repositories. The SoftCopy Librarian will compare the contents of that source with the repository you select and will update the status of the items in the source window. The updated status in the source window will indicate which items are potential candidates for updating the repository. The source window you selected will open with an updated status.

4. In the Source - Title window, identify the items that you want to transfer to your repository. You can filter the list to only show the items that are new or changed. Use the **Show New/Updated** choice in the Options menu in the source window.

You can sort the list so that all new and updated entries are clustered together. Single click on the heading of the Status column. The contents of the status column will be sorted alphabetically. All the “Updated,” “New,” “Installed,” and so on, entries to be grouped together in the same order (ascending or descending) as the Title column is sorted. If you click on the heading a second time it will change the sort to the opposite sort order. You can sort any of the other columns in the same way.

5. Select the items that you want to transfer. You can select and deselect items in several ways:

**Select a single item:**
- Left-click on any item. This will deselect any other items that have been selected.

**Select several items:**
- Press and hold the **Ctrl** key and left-click on the items you want. You can deselect in the same way.

**Select all the items:**
- Use the Select **All** choice in the Options menu. This choice is handy if you have filtered the list first to show only new and updated items.

**Deselect all the items**
- You can deselect all that you have selected with the Deselect **All** choice in the Options menu in the source window.

6. When you are satisfied with your selections, transfer the items that you selected to the repository you want to update. You can transfer in the following ways:

- Use the **Send to** choice in the File menu in the source window.
- Right-click in the source window, select the **Send to** choice, and the repository that you want to update.

  **Attention:** If you have selected several, you must not release the **Ctrl** key before you right-click or your choices will be deselected.

The Repository - Title window for the repository you selected appears. The items you transferred now appear.

**Results**

After you have transferred to a repository you can perform maintenance on the contents such as removing any old files that were replaced by new versions.

**Maintaining a Repository**

After you have transferred to your repositories, you can:

- Maintain each repository by removing old versions for which there are new replacements
- Maintain one repository as a model and transfer copies of the model to identical repositories.

When you are ready to maintain a repository, you can do the following:
1. In the Repository - title window, make sure that you are using the Shelves view.

**Note:** We recommend that you work from the Shelves view, and always delete books by deleting their shelves.

When you delete associated publications, if the reference count goes to 0, those associated publications are automatically deleted along with the shelf.

We recommend that you only use the Files to locate and delete “orphaned” associated publications. Orphans have a reference count of “0” in the list.

2. In the Repository - title window, identify the shelves that you want to delete.

Items that are potential candidates for deletion are identified by the filename of their newer version in the Replaced by column. For example:

<table>
<thead>
<tr>
<th>Title</th>
<th>Filename</th>
<th>Replaced by</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2 for OS/390 V5</td>
<td>dsnsh0f2</td>
<td></td>
</tr>
<tr>
<td>QMF V3R1.1 for MVS</td>
<td>dsqms004</td>
<td>dsqms006</td>
</tr>
<tr>
<td>QMF V3R2 for MVS</td>
<td>dsqms006</td>
<td>dsqms007</td>
</tr>
<tr>
<td>QMF V3R3 for MVS</td>
<td>dsqms007</td>
<td></td>
</tr>
<tr>
<td>DITTO V2 for MVS</td>
<td>dutba00</td>
<td></td>
</tr>
<tr>
<td>DataHub for OS/2 V2R1.0</td>
<td>eqq2bs00</td>
<td>eqq2bs02</td>
</tr>
<tr>
<td>dpAccounting Manager/MVS R1.2</td>
<td>eoubks01</td>
<td>eoubks02</td>
</tr>
<tr>
<td>dpAccounting Manager/MVS</td>
<td>eoubks02</td>
<td></td>
</tr>
<tr>
<td>OPC/ESA R2.0</td>
<td>eqq2bs00</td>
<td>eqq2bs02</td>
</tr>
<tr>
<td>OPC/ESA R2.1</td>
<td>eqq2bs02</td>
<td></td>
</tr>
<tr>
<td>OPC/ESA R1R3.1</td>
<td>eqq3bs04</td>
<td></td>
</tr>
<tr>
<td>CallPath CICS/MVS</td>
<td>eqzmsh00</td>
<td></td>
</tr>
</tbody>
</table>

You can analyze the candidates in one of two ways:

- Simply sort the list so all shelves that can be replaced are clustered together. Single click on the heading of the Status column. The contents of the status column will be sorted alphabetically. All the “Replaced by” entries will be grouped together in the same order (ascending or descending) as the Title column is sorted. If you click on the heading a second time it will change the sort to the opposite sort order. You can sort any of the other columns in the same way. This method works; however, it may miss some shelves which do not follow the file naming conventions.

- We recommend that you use this, more thorough method. Sort on the Filename column. Scroll down to a row that has a filename in the Replaced by column. The filename in the Replaced by column should match the filename in the Filename column in the next row. For example:

<table>
<thead>
<tr>
<th>Title</th>
<th>Filename</th>
<th>Replaced by</th>
</tr>
</thead>
<tbody>
<tr>
<td>dpAccounting Manager/MVS R1.2</td>
<td>eoubks01</td>
<td>eoubks02</td>
</tr>
<tr>
<td>dpAccounting Manager/MVS</td>
<td>eoubks02</td>
<td></td>
</tr>
</tbody>
</table>

If the names in the Title column match, the newer file is actually a replacement for the older one. If the titles do not match, the file name of the apparent “newer” shelf probably does not conform to the file naming conventions and is not an actual replacement.

3. Select the items that you want to delete.

You can select and deselect in several ways:

- **Select a single item:** Left-click on any item.

  This will deselect any other items that have been selected.

- **Select several items:** Press and hold the Ctrl key and left-click on the shelves you want.

  You can deselect items out in the same way.

- **Select all the items:** Use the Select All choice in the Options menu.

- **Deselect all the items:** Use the Deselect All choice in the Options menu.

4. When you are satisfied with your selections, delete what you selected.
You can delete in the following ways:

- Use the Delete choice in the File menu in the repository window.
- Right-click in the repository window and Select the Delete choice.

Note: If you have selected several items, you must not release the Ctrl key before you right-click or your choices will be deselected.

A confirmation window will appear.

5. In the confirmation window, click the Yes button.
   The items you selected are removed from the repository.

After you have maintained your repository, you can use this repository as a model to create identical repositories.

---

### Replacing or Excluding Associated Files

Occasionally, a Shelf in one of your repositories might be missing a Book. If that happens, you might see any of the following:

- A Shelf listed in one of your source windows has a status of “Partial” when compared to one of your repositories. The corresponding shelf in your repository is missing an associated file.
- A Shelf listed on the Shelves tab of one of your repositories appears in “red”. The Shelf is missing one or more books.
- A file listed on the Files tab of one of your repositories appears in “red”. The file is missing from its Shelf.

The reference count for a missing associated file is negative and the number indicates the number of shelves that are missing that file.

<table>
<thead>
<tr>
<th>Title</th>
<th>Filename</th>
<th>Replaced by</th>
<th>Filetype</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>OS/390 V2R10 AS Configuration</td>
<td>asumwa20</td>
<td>BOOK</td>
<td>-2</td>
<td></td>
</tr>
</tbody>
</table>

Note: The shelves that are missing the book appear in “red” on the Shelves tab.

You can replace the missing associated files from the IBM PUBLIB server on the Internet or you can exclude the missing associated file permanently. Excluding a file here actually removes it from the Shelf. It will not be listed in your repository, and BookManager will not be able to find it in the Shelf.

### Replacing Missing Books

To replace a missing associated file from the IBM PUBLIB server on the Internet, do the following:

1. Click on the Files tab.
2. Highlight the file (shown in red) that you want to replace.
3. Click on the Files choice on the menu bar.
4. In the Files menu, select Download from Internet.
   The associated file is replaced and it and its shelf will no longer appear in “red”.

### Excluding Missing Books

To exclude a missing associated file from its shelf, do the following:

1. Click on the Files tab.
2. Highlight the associated file that you want to exclude.
3. Click on the Files choice on the menu bar.
4. In the Files menu, select Exclude from shelf.
It will no longer appear in the list and the shelf will not appear in “red”.

**Removing Orphaned Associated Publications**

You might also want to identify and eliminate orphans. Orphaned documents files are not part of any shelf and, therefore, do not show up in a list when you want to locate and view files. They also take up space in your repository that you might need.

**Note:** While you can leave orphans in your repository, you can only view by opening them specifically by their filename.

To remove orphans, do the following:

1. Start the SoftCopy Librarian.
2. Open the Repository - title window for the repository that you want to review.
3. Click on the Files tab.
4. Look for books with a 0 reference count:

<table>
<thead>
<tr>
<th>Title</th>
<th>Filename</th>
<th>Replaced by</th>
<th>Filetype</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>OS/390 V2R7 Encina Bookshelf</td>
<td>asumya10</td>
<td>BKSHELF</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>OS/390 V2R8 LANRES Install Gd</td>
<td>ewx1c205</td>
<td>BOOK</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>IBM Softcopy Reader User's Gd</td>
<td>hlcrug01</td>
<td>BOOK</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

   You can scroll down the list or you can sort the Count column in the list. Sorting will bring books with a reference count of 0 to the top of the list.

5. Highlight the orphans.
6. Click on the File choice on the menu bar.
7. In the File menu, choose Delete.
   
   A confirmation window appears.
8. In the confirmation window, click the Yes button.
Chapter 15. Creating/Managing Your Own Softcopy and Associated Publications

This chapter describes how you can create your own softcopy shelves and associated publications and manage them with the Softcopy Librarian. It describes how to:

- Name your files so the Softcopy Librarian can manage them
- Create an exception file if you need one to resolve naming differences
- Create shelves and associated publications
- Transfer from a non-IBM CD to your host repository
- Transfer from your hard drive to your host repository

Naming Your Files So the Softcopy Librarian Can Manage Them

IBM developed and uses a file naming convention as a way to produce and distribute softcopy files that would have unique names.

This naming scheme has three purposes.
1. It prevents us from overwriting our own files that we ship to you.
2. It helps to ensure that IBM files don’t overwrite your files
3. It provides enough file information so the Softcopy Librarian can manage shelves and associated publications.

As you know, IBM has reserved file names beginning with the letters A-I and Q for the files that we distribute. These conventions apply to both software and softcopy files. You are free to use the remaining letters for your filenames without fear that we will interfere with them. To ensure that this happens, all IBM software products are assigned a 3- or 4-character product ID. Hardware product and non-product related documents are assigned IDs reserved specifically for that purpose and these IDs serve the same function as product software product IDs. For example:

- AFB   VS FORTRAN
- ADM   GDDM
- DSN   DB2
- IEA   OS/390 MVS

How Files Are Named

All that having been said as background, the current naming scheme for softcopy documents is as follows:

PPP BBB R S

or

PPPP BB R S

Where:

PPP or PPPP

Is the product ID or site assigned ID. This remains for the life of a version and is changed when there is a new product version. This is usually not applicable to non-product related documents, which usually retain their original for entire the life of the document.
**BBB or BB**

Is the publication ID, which is unique in the product library. This remains for the life of the publication. When there is a new product version, this ID can be changed as well.

**Note:** The first 6 characters must remain unchanged for the life of the publication. For our product, the life begins with a new version of the product and ends when that version is replaced.

**R**

Is a release identifier that denotes the release of the product. This number begins at 0 and is incremented by 1 up to 9 then to A and by one letter up to Z **each time the release number of the product is incremented**. This number or letter need not correspond with number of the release, it just needs to start at 0 and increment each time a new release is made available. This would not apply to non-product-related publications. For non-product publications this identifier should be set to 0 initially and should remain at 0 unless it is incremented because an older edition should remain available and may be updated along with the newer version.

**S**

Is the sequence number that denotes level. This number begins at 0 and is incremented by 1 up to 9 then to A and by one letter up to Z each time the publication is updated.

This scheme is designed to prevent an older publication ending up with a higher sequence number than a newer one. It provides for up to 36 levels for any single release and for up to 36 releases of a product. Hopefully, this will accommodate most situations.

**Important:** Some older publications might follow an earlier naming scheme as follows:

PPP BBB SS

or

PPPP BB SS

Because these filenames are currently created, maintained, and processed manually by the owners and the IBM Softcopy Center, over time and for various reasons, exceptions have crept into the practice of file naming. For example:

- Some filenames incorporate a release indicator somewhere in the book ID, which changes the ID over the life of the publication.
- Some filenames do not strictly increment the sequence number each update, resulting in a discontinuous series of numbers.
- Some filenames use only 7 character positions instead of 8.
- Some filenames only increment the last digit of the sequence number using the next to last for some other purpose.
- Some filenames for updates to older levels have ended up with a higher sequence number than the newer level.
- And some other variations.

**What If Your Old Shelf Names Do Not Work with the New Conventions**

Over time and for various reasons, your practice of naming your shelves might have created file names that are incompatible with the Softcopy Librarian’s conventions.

You might also have file naming exceptions for the following reasons:

- You are combining two or more shelves into one
- You are splitting a shelf into two or more shelves.

We strongly recommend that you convert your file names to the Softcopy Librarian’s conventions. If you are converting from your current naming convention, and, if for any reason, you have file names that
cannot conform, you can create an exception file to identify which new file names replace the old file names. The Softcopy Librarian uses this exception file to reconcile any naming differences when your customers transfer to their repository.

In general, you will need an exception file, whenever you have two related shelves, usually where one is a later version of the other, and:

- The first six characters of their file names do not match
  The later file will appear to the Softcopy Librarian as if it were unrelated to the earlier one.
- The first six characters match, but the last two characters (the sequence number or the RS value) of later file name are not numerically higher than the earlier one
  The later file will appear to be older than the earlier one.

If you need an exception file, continue with the instructions in [Creating an Exception File]. Otherwise, continue with the instructions in [Creating Your Own Shelves and Books with BookManager] on page 60.

Creating an Exception File

You might need to create an exception file for any of the following reasons:

- **You have old file names that cannot be reconciled** with the new conventions, and you want to convert them.
  The Softcopy Librarian cannot determine from the file names that an updated Shelf is related to an older one that it replaces. For example:

<table>
<thead>
<tr>
<th>Old Name</th>
<th>New Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>BADINAME.BKS</td>
<td>OKNAME00.BKS</td>
</tr>
</tbody>
</table>

  The entry in the exception file would look like this:

  OKNAME00.BKS BADINAME.BKS

  **Note:** The first entry on each line is the file name of the new file. The second entry is the file name of one or more files that are replaced by the new Shelf. Each entry is separated by at least one blank character.

- **You are combining two or more shelves into one.**
  The Softcopy Librarian cannot decide which shelves are being replaced by the combined bookshelf. For example:

<table>
<thead>
<tr>
<th>Old Names</th>
<th>New Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>ONEBKS02.BKS, UNIBKS00.BKS, TWOBKS02.BKS</td>
<td></td>
</tr>
</tbody>
</table>

  The entry in the exception file would like this:

  UNIBKS00.BKS ONEBKS02.BKS TWOBKS02.BKS

  You could, in this case, retain one of the old names for new file. For example, you could name the new file:

<table>
<thead>
<tr>
<th>Old Names</th>
<th>New Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>ONEBKS02.BKS, ONEBKS03.BKS, TWOBKS02.BKS</td>
<td></td>
</tr>
</tbody>
</table>

  Then, your exception file would need an entry for only one of the old files. The entry in the exception file would like this:

  ONEBKS03.BKS TWOBKS02.BKS

- **You are splitting a shelf into two or more files.**
  The Softcopy Librarian cannot decide which Shelf is being replaced by the new, separated shelves. For example:
<table>
<thead>
<tr>
<th>Old Name</th>
<th>New Names</th>
</tr>
</thead>
<tbody>
<tr>
<td>OLDBKS03.BKS</td>
<td>NEWTWO00.BKS</td>
</tr>
<tr>
<td>NEWONE00.BKS</td>
<td>OLDBKS03.BKS</td>
</tr>
<tr>
<td>OLDBKS03.BKS</td>
<td>NEWONE00.BKS</td>
</tr>
</tbody>
</table>

The entries in the exception file would like this:

NEWONE00.BKS OLDBKS03.BKS
NEWTWO00.BKS OLDBKS03.BKS

You could, in this case, retain the old name for one of the two new files. For example, you could name them as:

<table>
<thead>
<tr>
<th>Old Name</th>
<th>New Names</th>
</tr>
</thead>
<tbody>
<tr>
<td>OLDBKS03.BKS</td>
<td>OLDBKS04.BKS</td>
</tr>
<tr>
<td>NEWONE00.BKS</td>
<td>OLDBKS03.BKS</td>
</tr>
</tbody>
</table>

Then, your exception file would need only one entry for the Shelf with a completely new name. The entry in the exception file would like this:

NEWONE00.BKS OLDBKS03.BKS

To create an exception file, do the following:

1. Using an appropriate text or word processor, create a simple flat-text file with the name:
   **EBRSCL.EXC**
   
   Each line in this file represents the naming exception for one shelf.

2. For multiple shelves, enter each exception on a separate line.
   
   The first entry on each line is the file name of the new Shelf. The second entry is the file name of one or more that are replaced by the new Shelf. Separate each entry by at least one blank character.
   
   Your exception file might look like this:
   
   OKNAME00.BKS BADNAME1.BKS
   UNIBKS00.BKS ONEBKS02.BKS TWOBKS02.BKS
   NEWONE00.BKS OLDBKS03.BKS
   NEWTWO00.BKS OLDBKS03.BKS

   The entries in this example represent the changes:
   
   - On the first line of the example, a new version of a file (OKNAME00.BKS) replaces an old version with an incompatible name (BADNAME1.BKS).
   - On the second line of the example, two old files (ONEBKS02.BKS and TWOBKS02.BKS) have been combined into a single new file (UNIBKS00.BKS), and the new file replaces both older ones.
   - On the third and fourth lines of the example, an old file (OLDBKS03.BKS) has been split into two new files (NEWONE00.BKS and NEWTWO00.BKS), and both new files replace the old one.

3. **For workstation users**: Copy the exception file that you want on the media to the \SCRT\EXCEPT directory.
   
   **For host terminal users**: Download the exception file to the \SCRT\EXCEPT directory on the workstation you will use to create the media.

   **Note**: You must download the exception file as an ASCII file.

You are now ready to build the BookManager versions of the files you intend to distribute and to create shelves and indexes for them.

---

**Creating Your Own Shelves and Books with BookManager**

To create BookManager books and shelves, do the following:

1. Create a naming scheme for your books, shelves, and indexes that generally conforms to the file naming conventions described in "Naming Your Files So the Softcopy Librarian Can Manage Them" on page 57.
**Note:** You can use any first six characters you choose. Ensure that the first character does not conflict with the letters that IBM uses. You must adhere to the conventions for the last two characters.

2. Using an appropriate text or word processor, create source files for your books that are acceptable to a BookManager BUILD program. Refer to the BookManager BUILD for Windows manuals for the source coding that is acceptable.

3. Format your books for viewing using a BookManager BUILD program. Refer to the BookManager BUILD for Windows manuals for instructions on building books.

4. Decide how you are going to organize your books into shelves.

5. Create a Shelf and Index for each set of books you want in a separate Shelf.

6. Use the same filename for the Shelf and the Shelf Index. Refer to the BookManager BUILD for Windows manuals for instructions on creating shelves and indexes.

7. Use Softcopy Reader Organizer or Library Server to build a Shelf containing the new Books and Index.

**For BUILD for Windows users:** After you have built your books and created your shelves and indexes, you are ready to transfer them to your host repository. Refer to **Chapter 13, “Identifying the Sources of Content That You Want to Transfer,”** on page 49 and **Chapter 14, “Maintaining Your Repositories,”** on page 51 for instructions on setting your default source location and transferring your files.

**For BUILD/MVS users:** If you built you books, shelves, and indexes on your OS/390 host and you are using a host repository, you can copy your files directly into host repository. Refer to **Appendix D, “Managing Changes to Your Repository,”** on page 69 for instructions on manually updating your host repository and recreating its catalog.
Appendix A. Permitting More Than One Person to Maintain Your Repositories

Installing Softcopy Librarian on a server allows several customers, through shared access, the ability to maintain the same repositories.

1. Install the Softcopy Librarian in a directory which is on a drive shared by all customers with whom you want to be able to maintain your repositories.
   All customers must have read/write access and authorized IDs to the shared drive.
2. Have one of the customers access the shared directory and do the following:
   a. Start the Softcopy Librarian.
   b. In the First time window, if there are any files to be migrated, migrate them now.
   c. Define their (the customer's) CD-ROM drive letter.
3. Have each of the other customers, start the Softcopy Librarian.
4. In the First time window, do not attempt to migrate any repositories, but have your customers define their default CD-ROM drive letter.
5. For any repositories that will require FTP for processing, have your customers update the Repositories Properties - FTP Logon Information window with their userid and password. This information will be maintained at the individual workstation level.

Each customer will have their own sources but will be able to share access to and maintain the same repositories. They each can create new repositories, and the repositories will be accessible to everyone.

Because there is no file locking, only one customer should work with a repository at a time. This is a manual enqueue/dequeue procedure.
Appendix B. Changing the Definition of Your Repository

You can change the definition of a repository for several reasons:

- You may want to change the following attributes of your repository:
  - High-level qualifiers or directories
  - SMS classes
  - DASD device
  - DASD volume
  - FTP site commands
- You may want to share the administration of your repository with others

Changing the Attributes of Your Repository

To change any of the attributes of a host repository that you previously defined, do the following:

1. Start the Softcopy Librarian.
2. From the Sources and Repository window - select a Repository to update.
3. Select File, then Properties.
4. The Repository Properties - Repository Name window appears.
   - Make your changes in the windows and select OK.
5. If you change the following items in the definition of your repository:
   - The location of the repository (HLQs or directories)
   Then in the SoftCopy Librarian panel, you must recreate the catalog for your repository:
   - From the Sources and Repository window - select a Repository to update.
   - Select File, then Create Catalog.
Appendix C. Deleting a Repository

To delete the softcopy files and the repository definition, do the following:
1. Start the Softcopy Librarian.
2. From the Sources and Repositories window:
   a. Select a repository to delete.
   b. Select File, Open
3. In the Repository - Title window:
   a. Select options, select ALL to highlight all the shelves
   b. Select File, Delete.
   c. In the Confirmation window, select Yes

The shelves and files should disappear from the Repository - Title window.
4. Return to the Sources and Repositories window and do the following:
   a. Select the repository to delete.
   b. Select File, Delete
   c. In the confirmation window, select Yes.

The repository will disappear from the Sources and Repositories window.

To delete only the repository definition, do the following:
1. Start the Softcopy Librarian.
2. From the Sources and Repositories window:
   a. Select a repository to delete.
   b. Select File, Delete
   c. In the confirmation window, select Yes.

The repository will disappear from the Sources and Repositories window.
Appendix D. Managing Changes to Your Repository

This appendix explains how the Softcopy Librarian can help you manage:

- Shelves and associated publications that you unload from tape or copy directly into your repository.
- Changes made to the shelves in your repository.

Unloading or Copying Softcopy Files from Tape or other Sources

When unloading softcopy files from tape or other sources, complete the following steps so that these files can be managed by Softcopy Librarian.

1. Make sure that you have followed the procedures for setting up your host and defining your host repository to the Softcopy Librarian described in Chapter 8, “Setting Up a z/OS or OS/390 Host Repository Using Sequential Data Sets,” on page 27.
2. Unload the tapes or copy the files to the HLQ or directory that you are using for your repository.
3. Start the Softcopy Librarian.
4. In the Sources and Repository window, do the following:
   a. In the Sources and Repository window, select the repository you updated.
   b. Select File, create catalog.

When the catalog has been created, the update is complete.

Item Changes in Your Repository

If any additions or changes to the files in your repository are made outside of Softcopy Librarian, then you must erase the cache that the Softcopy Librarian uses and recreate the catalog for the repository.

To help the Softcopy Librarian keep track of these changes, do the following:

1. Start the Softcopy Librarian.
2. In the Sources and Repository window, select the repository to be updated.
3. Select File, erase cache.
   a. At the Confirm Dialog window, select Yes.

   Cache will be erased and the Catalog Function will be performed.

When the catalog has been created, the update is complete.
Appendix E. Summary of Changes Made in Previous Editions

This appendix summarizes the major changes made in the previous editions.

Changes made to the Seventeenth Edition
Updated Softcopy Librarian for Windows Vista Support
Installed an icon on the Windows desktop for IBM Softcopy Librarian.

Changes made to the Sixteenth Edition
Updates made to the following areas:
- Updated the IBM Web site for downloading the latest version of Softcopy Librarian
- Included miscellaneous editorial updates

Changes made to the Fifteenth Edition
Updates made to the following areas:
- Hardware and software requirements
- Information about Library Server
- Updates to how PDF files are handled
- Updates to Maintaining Your Repositories

Changes made to the Fourteenth Edition
Updates made to the following areas:
- Hardware and software requirements
- Internet connection
- Migration from previous versions of Softcopy Librarian

Changes made to the Thirteenth Edition
Removed support for Windows NT 4.0, and replaced the URL for the IBMLink Web site. editions of the Softcopy Librarian: User’s Guide.

Changes made to the Twelfth Edition
Made terminology changes regarding the new "Extended Shelf" architecture.

Changes Made in the Eleventh Edition
- Updates to Appendixes A through D. Clarifications were made to the procedures relating to working with repositories, such as:
  - More than one person maintaining your repository
  - Changing the definition of your repository
  - Deleting a repository
  - Managing changes to your repository
Changes Made in the Tenth Edition

- Softcopy Librarian can handle shelves and associated publications created by OEM companies that use one of the IBM BookManager Build products.
- Updated IBM Web and e-Mail addresses for support and free downloads.
- Corrected directory path statement syntax in several examples
- Elimination of "EBRMGMT" as the default HLQ for the Shelf List (BKLSHELF) and establishing this field as a required entry.

Changes Made in the Ninth Edition

- Miscellaneous editorial updates.

Changes Made in the Eight Edition

- The Softcopy Librarian has been rewritten in Java.
- A new user interface lets you display multiple source windows and multiple repository windows simultaneously. Refer to Chapter 14, “Maintaining Your Repositories,” on page 51.
- You can transfer files directly between source and repository windows and between repository windows. Refer to Chapter 14, “Maintaining Your Repositories,” on page 51.

Changes Made in the Seventh Edition

New Information

- The code for the current version of the Softcopy Librarian is now located in the \SCL directory on the CDs in the IBM Online Library. Refer to Chapter 4, “Installing the Softcopy Librarian,” on page 11.
- In the OS/390 Collection the Softcopy Librarian is now located on the “Tools” disc. Refer to Chapter 4, “Installing the Softcopy Librarian,” on page 11.
- Buttons for selecting the source have been added to the Transferring softcopy to the repository choice in the main menu of the Softcopy Librarian window.

Changes Made in the Sixth Edition

New Information

- Information on maintaining your repositories from IBM's and other Web sites have been added. Refer to Chapter 1, “Introducing the Softcopy Librarian,” on page 1.
- Procedures for defining the IBM PUBLIB and other Web sites as the source to transfer have been added. Refer to Chapter 13, “Identifying the Sources of Content That You Want to Transfer,” on page 49.
- Procedures for transferring files from the IBM PUBLIB and other Web sites to your repositories have been added.

Changes Made in the Fifth Edition

New Information

- Procedures for installing and starting the OS/2 version of the Softcopy Librarian have been included. Refer to Chapter 4, “Installing the Softcopy Librarian,” on page 11 and Chapter 5, “Starting the Softcopy Librarian,” on page 13 for more information.
- Minor changes for using the OS/2 Softcopy Librarian have been made throughout.
- A method for automatically checking if a later version of the Softcopy Librarian is available from the IBM Web site has been added to the Windows version of the Softcopy Librarian. Refer to Chapter 4, “Installing the Softcopy Librarian,” on page 11 for more information.
Changes Made in the Fourth Edition

New Information

- A check box that permits you to ignore a descriptor file that contains errors on a CD has been added to the SCL Setup - Location of Files to Install window. Refer to Chapter 13, “Identifying the Sources of Content That You Want to Transfer,” on page 49 for more information.

- Two new choices that control whether the Ctrl key is required to make additional selections have been added to the Options in SCRT - Shelves View and SCRT - Files View windows. The Extended Selection choice requires the use of the Ctrl key and the Multiple Selection choice does not require the use of the Ctrl key.

Changes Made in the Third Edition

New Information

- Information describing how to use the “cache erase” function when you make manual changes to the contents of your repository. Refer to Chapter 12, “Creating and Recreating the Catalog for Your Repository,” on page 45 for more information.

- Information has been added on the automatic creation of a descriptor file for non-IBM CDs.

- Information describing how to exclude “missing” files from the shelves in your repository has been added. Refer to Chapter 14, “Maintaining Your Repositories,” on page 51 for more information.

- A new section has been added describing how to create an exception file. Refer to “Creating an Exception File” on page 59 for more information.

- A new appendix has been added describing how to change to your repository definition and how to permit more than one user to maintain your repository through the use of shared work files. Refer to Appendix B, “Changing the Definition of Your Repository,” on page 65 for more information.

- A new appendix has been added describing how to remove a repository. Refer to Appendix C, “Deleting a Repository,” on page 67 for more information.

- A new appendix has been added for independent software vendors (ISVs) who want to package and distribute product documentation enabled for the Softcopy Librarian.

Changed Information

- The method for defining host repositories using OS/390 sequential data sets has been significantly revised. Refer to Chapter 8, “Setting Up a z/OS or OS/390 Host Repository Using Sequential Data Sets,” on page 27 for more information.

- The chapter on defining host repositories has been split into two chapters, one for repositories using OS/390 sequential data sets and one for repositories using the hierarchical file system of OS/390 UNIX System Services. Refer to Chapter 8, “Setting Up a z/OS or OS/390 Host Repository Using Sequential Data Sets,” on page 27 and Chapter 9, “Setting Up a z/OS or OS/390 Host Repository Using the UNIX System Services HFS,” on page 33 for more information.

- The chapter on creating exceptions files has been combined with the chapter on creating and managing your own shelves and associated publications. Chapter 15, “Creating/Managing Your Own Softcopy and Associated Publications,” on page 57 for more information.

- Because the Softcopy Librarian now has the ability to automatically create descriptor files, the chapter on creating descriptor files has been deleted from this edition.

- The chapter on distributing on media your product bookshelves and books to your customers has been expanded and made into an appendix.

- Minor editorial changes have been made throughout this manual.
Changes Made in the Second Edition

New Information

- Hardware requirements for a repository on a LAN server or PC workstation has been added. Refer to Chapter 2, “Hardware and Software Requirements,” on page 5 for more information.

- A new chapter has been added describing how to set up repositories on LAN servers and PC workstations. Refer to Chapter 11, “Setting Up a PC/LAN Repository,” on page 41 for more information.

- Information on editing names from the repository maintenance facility has been added. Refer to Chapter 14, “Maintaining Your Repositories,” on page 51 for more information.

Changed Information

- New Web site for downloading the Softcopy Librarian code. Refer to Chapter 1, “Introducing the Softcopy Librarian,” on page 1 for more information.

- The information on defining an OS/390 host repository has been reorganized. Refer to Chapter 8, “Setting Up a z/OS or OS/390 Host Repository Using Sequential Data Sets,” on page 27 for more information.

- The section describing how to install the Softcopy Librarian has been revised. Refer to Chapter 4, “Installing the Softcopy Librarian,” on page 11 for more information.

- The information describing how to start the Softcopy Librarian has been reorganized. Refer to Chapter 4, “Installing the Softcopy Librarian,” on page 11 for more information.

- The information on using tapes has been moved into an appendix. Refer to Appendix D, “Managing Changes to Your Repository,” on page 69 for more information.

Technical changes or additions to the text and illustrations in this edition are indicated by a vertical line (|) to the left of the change.
Do You Have Questions, Problems, or Comments?

The IBM Softcopy Librarian is a free tool, supported through e-Mails as time permits. For support, send a note explaining your question, problem, or comment to: bookmgr@us.ibm.com

The IBM Softcopy Librarian software can be downloaded without charge from the IBM Bookmanager Web Site http://www-01.ibm.com/software/applications/office/bkmgr/.

IBM may use or distribute whatever information you supply in any way it believes appropriate without incurring any obligation to you.
Index

C
- catalog
  creating for host repository 45

D
description of Softcopy Librarian 1

F
- functions of the Softcopy Librarian 3

H
- host repository
  creating catalog for 45
  requirements 5

I
- installing
  Softcopy Librarian 11
- Internet connection
  setting up 23
- introducing the Softcopy Librarian 1

K
- Knowledge Center content
  transferring 51

M
- maintaining host repository 51
- managing your own shelves and books 57
- migrating
  from previous versions 25

O
- overview of Softcopy Librarian 3

P
- planning for repositories 7

R
- repositories
  planning for 7
  requirements
  host repository 5

S
- setting up a host HFS repository
  for Softcopy Librarian 34
- setting up host repository
  for Softcopy Librarian 28
- setting up PC/LAN repository
  for Softcopy Librarian 41
- setting up Unix server repository
  for Softcopy Librarian 37
- shelves
  transferring 51
- Softcopy Librarian
  books on tape 69
  creating catalog for host repository 45
  functions of 3
  general description of 1
  host repository requirements 5
  installation 11
  introducing 1
  maintaining host repository 51
  managing your own shelves and books 57
  migrating from previous versions 25
  OS/390 host repository setup
    in an HFS 33
    in sequential data sets 27
  OS/390 setup
    in sequential data sets 65
  overview 3
  PC/LAN setup 41
  planning for repositories 7
  setting up a host HFS repository 34
  setting up a proxy 23
  setting up host repository 28
  setting up Internet connection 23
  setting up PC/LAN repository 41
  setting up Unix server repository
    starting 13
  Unix-like setup 37
  uploading to host repository 49
  workstation requirements 5
  z/OS host repository setup
    in an HFS 33
- SoftCopy Librarian
  z/OS host repository setup
    in sequential data sets 27
    starting
      the Softcopy Librarian 13
  system requirements 5

T
- transferring content 51

U
- uploading
  to the host repository 49

© Copyright IBM Corp. 1997, 2015